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CHANGES FOR 2017

The following significant changes to the Organisers’ Guide have been made since the
previous year and are marked in the left hand margin. Other minor changes and corrections
are not marked.

Changes to Part 2 “During The Competition”
2.6 Airspace
Notification of new email address for BGA contact on Competition Airspace
Advice on requirements regarding MATZs
2.7 Distance Handicapped Tasks

New advice on Minimum Barrel Size
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INTRODUCTION

This document is a step-by-step reference guide to help gliding clubs organise and run a
British Gliding Association Competition.

There are four parts:

Part 1 “Preparation” explains the decisions you have to make and the things you have to
put in place to get your competition to happen.

Part 2 “During the Competition” gives in-depth advice on the things you must do and the
standards you should aim to achieve in the competition itself.

Part 3 “Checklists” are lists of the essential elements arising in each of the main disciplines
or activities involved in the competition and are included to help you avoid forgetting
something important.

Part 4 “Reference” contains information of a technical or complex factual nature.
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PART 1 - PREPARATION

With a significant period of pre-planning your competition is likely to be a success. Pre-
planning encompasses a number of tasks that could be delegated to other members of your
organisation.

1.1. BGA Requirements

The BGA will require the organising club to have agreed competition dates before the
December of the preceding year. The BGA also require that a minimum level of competence
and capability exists within the organisation team. The BGA can provide advice on this as
required. Email compscommittee @gliding.co.uk

1.2. Local Arrangements

It is important that other local arrangements are taken into account at the earliest opportunity.
Ensure that any planning and neighbouring airfield requirements are identified and suitably
addressed before a competition date is decided. Any significant local arrangements that
could affect the competitors should be included in the local rules. See the Local Procedures
Section for more detail.

1.3. Launching Capabilities

BGA Rules require that all competition gliders in any task group are launched within 1 hour.
This is a minimum standard. Minimizing the launch time increases opportunity for pilots to get
the best out of a small window of opportunity.

In order to achieve the required launch rate it will be necessary to identify the correct
number, type and availability of tugs well in advance of the competition. Remember that
large heavily-ballasted gliders will need more powerful tugs, so try to predict the mix of your
expected entries and plan accordingly. As a rule-of-thumb, expect each launch to take ten
minutes, so the minimum number of tugs for a 30-glider grid would be five. Allowing an extra
one for breakdowns, that means you should look to have six available.

Tug availability becomes notoriously difficult during the peak summer months so you should
start to contact tug owners and operators well in advance, in fact as soon as you have
decided on a date. You may even want to take tug availability into account when deciding
which date to go for. If your dates clash with some of the big competitions, you may have a
problem. If you do find yourself short of dedicated tugs, you can try arranging for tugs to
ferry-in from local clubs just for your launch period. This is not ideal and can be expensive.

1.4. Infrastructure Arrangements

Actions to ensure that your club has the necessary facilities for the competition need to be
identified at the early planning stages. Additional photocopiers, public address systems,
briefing room facilities, catering, phone and internet requirements may be necessary to
ensure the smooth running of your competition.
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1.5. Organisational Team

Working together is prerequisite to ensuring a successful competition. It is recommended
that the organisation team should include some people who have been involved in running
competitions before. Where this is not possible, the team should consider practicing, in
advance, key areas of running a competition.

1.6. BGA Notification of Director and Club Contact Details

The BGA should be informed of the Director and Club contact details at the earliest
opportunity and no later than March 1% in the year of the event. These will be used by BGA
Competition and Awards Sub-Committee to arrange airspace co-ordination with NATS (see
ACN in 2. Section 2.6) as well as to establish a line of communication for updates to the
organising club throughout the year. The following detail is required:

. Club telephone number during event

. Club email address

. Director’'s email address

. Director’s telephone number during event (mobile)
. Dates of event

. Expected number of gliders and tow planes

. Radio frequency to be used for finishing

Where clubs have a problem with releasing personal contact details of individuals,
consideration should be given to providing depersonalised email addresses
(director@thiscomp.uk) and the use of a low-cost pre-paid mobile telephone during the
competition.

1.7. Roles and Responsibilities

To ensure that your organisation works together as a team to run a safe and well organised
competition it is important that each role within the team is defined.

Competition Director
The Director has overall responsibility for ensuring that suitable personnel, equipment and
facilities are available for the efficient organisation and running of the competition.

Directors must be fully conversant with the rules and are responsible for ensuring
compliance.

Directors should also double-check tasks to ensure safe routing, especially of final glides.

The Director should maintain an overview of the competition to ensure that all elements are
being brought together to achieve a successful competition.

Key Officers
The Competition Director must appoint the following key officers as a minimum:

. Deputy Director

. Task Setter }

. Airspace Officer } These two roles must not be the same person
. Safety Officer
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Control

“Control” refers to the admin and communications centre of the competition. Usually a
dedicated area set up by the host club and equipped to deal with all of the administration and
communication tasks associated with the competition and used as a base and meeting point
for the Director and Competition Officials. A well-run and well-equipped Control Centre is a
major asset at a competition. While it is not necessary for operation of Control to be under a
single individual, it does need to be run by competent people who are familiar with, or can be
trained in advance in the processes.

Additional Roles

Additional roles will be required to run the competition. It is good practise to assign these
roles to individuals; not only does this empower the individuals, it should allow the Director to
maintain an overview of the entire competition. While one individual may take on more than
one role it is important the Key Officers should not have additional duties placed upon them
which may impact on their ability to perform their primary role.

Additional roles which will be required:

. Scorer

. Meteorological interpreter and presenter
. Launch Marshall

. Tug Master

. Catering Manager

. Social Organiser

1.8. Use of the Internet

The internet is pretty much inescapable for organisations wanting to run a gliding competition
nowadays. It can be used for benefit in so many ways.

Competition Management

You may wish to make use of one of the web packages that help you manage your
competition, such as Onglide, or you may prefer to set up you own home-grown system.
However you do it, pilots will expect to be able to apply to enter your competition on-line.

Communication during the Competition

The internet can be a valuable way of distributing information to the pilots during the
competition. If you are using a home-grown website for your competition, consider building a
page that competitors can access to get information such as briefing times, grid-before
briefing instructions, NOTAM files, etc.

Real-time Competition Reporting

The gliding community nowadays expects to be able to follow competitions on-line. (It's
about nurturing the dream). Don’t neglect this side of things. Today’s on-line followers may
be next year’'s competitors. Publishing a competition blog and posting photographs can
really enhance the reputation of your competition and your club. Specialist packages can be
used, but a lot can be done with sites like Facebook and Flickr.

1.9. Entry Administration

April 2016 ©British Gliding Association 2016 Page 7 of 78



BGA Competition Organisers’ Guide

As soon as your competition is open for entries, you can expect to receive enquiries, entries
and deposit payments. In order to ensure that these are handled correctly it is important that
these are administered carefully. You may wish to consider a web-based system that can
visibly show the status of pilots who have entered. It is considered good practice to have a
separate bank account for monies received as reconciliation of the entry fees can be
notoriously difficult if not administered correctly.

1.10. Local Procedures

Rule 1.3 of the Competition Rulebook defines the requirement for Local Procedures (or Local
Rules as they are more commonly called).

This is an important document that the organizing club will have to write, obtain approval for
and publish no later than three weeks before the competition. Local Rules are normally
published on the competition web-site or emailed to participants. If you don’t already have a
template for this document at your club, go on-line and have a look at some of the
documents published on other competition web-sites. This should give you an idea of what
the competitors will be expecting.

An important requirement is that details of temporary airspace restrictions already
announced at time of publication should be included in the Local Rules. It is appreciated that
many restrictions crop up by NOTAM with little warning but many are known months in
advance including RA(T) protecting Red Arrows displays and other critical activity.
Publishing the known stuff early helps to minimize the amount of new information that has to
be absorbed by the pilots at the beginning of the competition.

As well as other content required by the Rule Book, the local rules must contain a reminder
to fly within the requirements of the Law, namely the UK implementation of SERA
(Standardised European Rules of the Air) and its associated UK exceptions regarding low
flying and reckless or negligent endangerment of any person or property.

The local rules must identify the boundary of the airfield.

Care should be exercised in defining the boundary of the airfield taking the following key
factors into consideration:-

. Legal status

. Landowner’s permission

. Airfield insurance cover

. Public safety (access and H&S)
. Aviation safety

The Competitions and Awards Committee must approve all Local Procedures. Please submit
them in good time by email to compscommittee@gliding.co.uk. If you are not contacted
about your Local Rules within 14 days then you can assume they are acceptable but every
effort will be made to confirm acceptance as appropriate within this time.

1.11. Publication of Competition Airspace Files

These days there is almost universal use in gliding competitions of moving-map displays as
aids for navigation and airspace awareness. Many types of equipment are available and
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there is more than one format and several potential sources of airspace files. There is a
strong possibility that pilots in your competition may be using airspace files which differ
significantly from each other and (more importantly) from the file that you will be using for
scoring and for checking for airspace infringements.

To help pilots to be on the “correct” airspace file and to avoid any misunderstanding, it is
recommended that the airspace file which will be used by the organisation for scoring and
infringement checking should be published. Pilots can, if they wish, make use of it
themselves, or, if they do not, they will at least have been given the opportunity. Details of
the file and where it can be downloaded should be given in the Local Rules.

If temporary airspace restrictions are known to affect your competition, you may wish to
include these in your “Official Airspace File”. Likewise, if you intend to make use of any of
the established airspace concessions (E.G. The Daventry Box), you may want these
represented in your file as well.

Whether you want to use a competition-specific file or simply one that matches the latest
CAA chart (plus amendments) there is an organisation that can help:-. Navboys, the
instrument and Naviter/SeeYou agent has kindly agreed to make competition-specific
airspace files in SeeYou format, available to competition directors on request. Contact details
for Navboys and guidance on how to make use of this service are given below:

Note that, due to differing opinions on how such things as ILS feathers, Danger Areas,
Unlicensed Airfields etc. should be displayed (if at all) it will be necessary to be quite clear
about your requirements before making contact with Shaun.

Navboys Ltd
Hambridge Barn
Hambridge Road
Newbury

Berks

RG14 2QG

Email shaun@navboys.com, tel 07973 748063

Working from the published UK open air text file on the World Wide Turn Point Exchange
plus any local amendments, we will convert the txt file into a SeeYou .cub file for publication.

1.12. Emergency Action Plan

The pre-planning to the event should establish an emergency action plan so that operational
and communication systems are available for the possibility of an unplanned event.

It is recommended that this system is known to all key personnel before the competition and
areas that require testing are practiced, where necessary, before the start of the competition.

The emergency action plan should be able to deal with the following, non-exhaustive list:
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o Off-site or on-site accident involving damage to one or more aircratft.
o Off-site or on-site accident involving injury or fatality to one or more persons.

It may be necessary to have a reactive press briefing available for any of the above and/or
mechanisms to ensure that unnecessary media access to any incident does not impede the
emergency services.

If your club does not already have an emergency plan which can be adapted to cover the
needs of the competition, you are strongly encouraged to make use of the BGA’s published
Post Accident Plan. This is an excellent template on which to base your own Emergency
Action Plan. It can be downloaded from the BGA website at:

www.gliding.co.uk/bgainfo/safety/forms/postaccidentguide.pdf

1.13. Competitors are Customers

One final, but very important, point is the need to treat your competitors right. You won’t go
far wrong if you just remember that they are your customers and treat them accordingly.
They will have paid money to enter your competition and are likely to spend considerable
sums at your club during the competition. They will probably have taken time off work and
will be on holiday. It's your organisation’s responsibility to make their experience as pleasant
as possible. Don’t forget that it's not just the flying that counts. Everything from the quality of
communications, the club facilities , the friendliness of club-members and competition
officials, to the quality of the catering and the availability of evening and scrub-day
entertainments are just as important as the quality of the briefing and task-setting. If you want
places at your competition to be in demand, you will need to pay attention to all of these
things.
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1.13. Top-Level Timeline

The following table provides an overview of the major decision and action points that need to

be addressed by a club wishing to organise a competion.

When

On decision to

What

Who Notes/Detail

bid for a N .
. . . Respond to Invitation to bid sent out to Club
Nationals or Prepare Bid Document and submit Host Club p
) . Chairmen by the BGA
Championship
Event
On Decision to
Host a . . . Submit competitions details To the BGA by
Regionals or Register your competition with the BGA Host Club March 1% at the latest.
Unrated Event
9monthsto 1 Appoint Director and Organising Host Club See “Organisational Team” in Part 1 of this
year ahead Committee (OC) Guide.
ASAP If . i . . .
Regionals Or Decide entry numbers and whether Director This could be flexible depending on entry
Unrated single or multi-class oc numbers, but needs to be planned
ASAP Read the Organisers Guide From Cover See Note Anyong r.10t experienced in running
to Cover competitions.
Periodically Develop action plan based on main headings
until N Organising Committee Meetings oc below. ReV}ew progresg agglnst plan. Take
Competition prompt action to contain slippages and
opens rectify problems.
Director See “Roles & Responsibilities” in Part 1 of
ASAP Allocate Official Roles and review other this Guide. Try to arrange that every key role
manpower requirements oc has a back-up in case of iliness or absence
during the competition.
Director Identify any weaknesses and develop plans
ASAP Review infrastructure and site facilities to rectify, if necessary. See “Infrastructure
ocC Arrangements” in Part 1 of this Guide.
Take early action to source any additional
ASAP Review tug availability Tugmaster tugs that will be required. See “Launching
Capabilities” in Part 1 of this guide.
. o . See “General Communications and
ASAP Review Communication and Radios oC
“Competition Radio” in Part 2 of this Guide
Start work on Catering, Entertaiments Develop a programme of events for scrub
ASAP . . ocC .
and/or Social planning days and evenings.
If you are running a Nationals, much of this
Decide Entry Fee, Deposit amount and will have been in your bid, so will be fixed.
due dates. Also policies regarding
ASAP discounts/refundsetc. Identify any other oC

charges you plan to make (e.g Caravan
pitches, bunk house fees etc.)

Make sure you anticipate any questions you
might be asked by potential entrants
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Set up Admin system for management of
entries and receipt of fees. Include

See “Entry Administration” in Part 1 of this

ASAP . oC Guide. Make sure you have this in place
procedure for management of a waiting before publicising vour competition
list if the competition fills up P 9y P
- . Several routes are available for this, including
Publicise Competition. ] .
printed media such as S&G, although the
ASAP oC . . «
Dates . Entrv Fees etc Internet is now the default medium. See “Use
' y of the Internet” in Part 1 of this guide.
As entries are Acknoyvledge entries and the rgcelpt of Comp Don't leave your customers in the dark.
made deposits and balances by email Admin
Keep waiting-list pilots informed.
If competition Monitor and manade waiting list Comp Communicate promptly when places become
becomes full 9 9 Admin available. Don’t leave them wondering what is
going on.
In Good Time Prepare or Review Emergency Action Safety
Plan
Quarter 1 of Familiarise with Changes to Rulebook . .
o . . ) , . Ensure rest of team is briefed where
Competition for this year and review any Organisers Director necessar
year Briefing Notes from the BGA. y
Monitor airspace changes or issues and
NLT 2 months begin to develop awareness of advance Director
out Notams and RA(t)sfor period of
competition
If C tition Ai file is to b d.
NLT 2 months Mal?emr?sc:e?snar Ir;s;(r:,eelr:;tstoe use Airspace See “Publication of Competition Airspace
out S y 9 P Files” in Part 1 of this Guide.
provide it.
NLT 2 Months ertg or update Local .Rulesmcludlng . See “Local Procedures” in Part 1 of this
section on Advance Airspace Director .
out ; Guide
Information
Make sure you allow enough time for the
In good time Submit Local Rules to BGA Comp . approval process to take place, including
. Director . .
(see note) Committee for approval possible amendments, and still be able to
publish 3 weeks before competition starts.
NLT 3 weeks Publish approved Local Rules with .
. . . Director
before start . advance airspace information
NLT 3 k
weexs . o . . See “Publication of Competition Airspace
before start of Publish Competition Airspace file Airspace S . .
. Files” in Part 1 of this Guide.
Competition
3 experienced current competition pilots not
In good time Appoint Competition Stewards Director competing or in an executive role in the
competition organisation.
NLT 1 Week Prepare Additional Penalty Airspace File See “How to produce and Additional Penalty
Before . Tasksetter . s . .
. if to be used Airspace File” in Part 3 of this guide
Competition
NLT 1 Week )
Before Conduct final run-through of processes ocC While there’s still time to fix any problems
. and systems.
Competition
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Set up competition infrastructure.

Last few days Control, Briefing Areas, Signage etc. oc
Evening
Before Registration Control See “Registration” in Part 2 of this Guide
Competition
To include site and local airspace
information, rules changes since last
Opening Day year and introduction of Comp Officials. Director Site and local airspace info may need
Briefing Appoint Pilot’'s Safety Committee. Show repeating or emphasising at daily briefings
Prizes and Trophies. Any housekeeping
issues.
ASAP during Initial meeting with PSC to confirm . See “Pilots’ Safety Committee” in Part 2 of
. Director . .
Competition Terms of Reference this guide.
. . Publish results at appropriate level. Scorer/As  Don’t underestimate the value of keeping the
Daily During . L . . . .
- Provide competition information via appointed world at large informed about your
Competition - . . . .
Competition Blog or similar service by Director competition.
ASAP after the  Submit Director’s report to the BGA . See “Director’s Report” in Part 4 of this
o . Director )
competition Comps Committee Guide.
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PART 2 - DURING THE COMPETITION

2.1. The Role of the Director

Once the competition gets underway, the Director’s responsibility is to see to it that all the
resources of the organisation work together to make best use of the available time and
weather while achieving the standards of safety and sportsmanship expected; all while
staying within the Rules. See the Reference Section for an example of the daily schedule at
a single-class Regionals and the activities that have to be managed and the decisions that
have to be made.

2.2. Competition Control

It is good practice to designate a room or area to be used exclusively as an office/meeting
area for the duration of the competition. As well as providing an office environment for the
administrative tasks that have to be performed and a place where competition officials can
meet, it is helpful as a focus for all of the organisational issues that will arise during the
competition. It also ensures that competitors have a place to go to for help or advice.

Central Information Point

Control is where competitors and others will expect to get answers to questions or make
contact with the Organisation. It is also the place where messages to competitors and others
can best be managed. As the message hub of the competition, it is the ideal place to site:

e Competition telephones

e Air Band Base Station (for pre-launch announcements and start and finish line
communications)

¢ Ground Radio Base Station (for contacting competition officials out on the airfield)

e PA system (for making general announcements in the communal areas)

Ideally the control centre should be manned throughout the competition day. It should be
lockable.

Start and Finish Line

It is essential that gliders in the air are able to receive clear readable transmissions from the
organisation on the ground. Start and finish radio communication is best carried out using a
base-station with a decent aerial to ensure adequate range, rather than less powerful hand-
held radios. It is good practice to site the equipment in or near the control centre.

Starts & Finishes

Although scoring is done exclusively from flight recorder files, it is still a requirement that start
and finish times should be recorded as they happen. Apart from the obvious safety
implications of knowing whether a glider has started or finished, the recording of this
information allows crews and others to keep abreast of the progress of the competition
(especially if it is published on the internet) and may also allow faster calculation and
publication of preliminary scores.
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Landouts

One of the most valuable tasks of the Control Centre is the coordination of land-out
information. There should be a dedicated telephone used for this purpose the number of
which should be printed on all task sheets every day, along with at least one back-up
number. Clear procedures should be in place for the reception of landout information and to
ensure that it is passed to crews accurately and without delay. Records should be kept of all
landouts and the progress of the returning retrieve teams so that all gliders are accounted for
before the end of the day.

The Organisation is responsible for invoking the emergency procedure in the case of a
missing aircraft. For this reason itis ABSOLUTELY NOT ACCEPTABLE to permit
competitors to contact their crews and arrange retrieves without involving Control. This
should be stated in the Local Rules and emphasized at briefings. Consideration should be
given to applying penalties, if necessary, to enforce this.

Flight Recorders (FRs)

With the increased use of removable memory devices and even email submission of FR files,
there is much less need to manage the reception of FRs. However, not all pilots have the
most modern equipment, so provision should be made to receive recorders after the finish
and keep them securely, possibly overnight.

Even memory devices, although small and quickly downloadable, may need to be retained
for use by the scorer. Again a secure means of recording their reception and their
safekeeping should be in place.

2.3. Reqistration

Most BGA competitions start on a Saturday, with competitors arriving on the Friday afternoon
and evening. The competition cannot start until this registration process is complete so the
time available is limited to the few hours available on Friday evening, with a very short period
to deal with stragglers on the Saturday morning. If the weather looks good on the first day,
no-one is going to be pleased with a delayed briefing caused by late registrations. Pilots
generally understand this and cooperate, although there will be the odd one or two who
genuinely can’t get to the site until the Saturday morning. Whatever happens, a major
priority for the organisers is to ensure that they are on the ball and are NOT the cause of any
delay.

Here are some key points to cover in your planning for that all-important Friday evening:

o Registration area clearly signposted?

e There will be a queue, can you provide seats?

¢ Have a checklist so you don’t forget to do everything with each competitor.

e You may be taking money (balances of fees and/or launch pre-payments). Have you
got a process for this? Have you somewhere to put cheques and cash and a process
for dealing with card payments?

e A pre-prepared file for registration forms and other competitor information?

If you are using a web-based competition management system, you will need to have a
computer with Internet access at the Registration point and someone trained in its use.
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The BGA registration form is available on the BGA website both in PDF and interactive
format. Organisers may create their own online form as necessary as long as it contains all
the details on the BGA form as a minimum requirement including declaration.

Those registration forms completed online should be printed off so that pilots may personally
sign the declaration. The forms must be retained after the event in case of follow-up action
being necessary.

It has always been a requirement that every competitor in a UK rated competition holds a
valid FAI competition licence. This is now the only mandatory item to be viewed at
registration. The FAI licence numbers of every pilot must also be detailed in the results to be
submitted to the BGA as soon after the competition as feasible so please take the
opportunity at registration to collect the data of license numbers in a form that may be
accessed later. Scanning them into the computer is a good method. Give consideration to
recording this data in the scoring system from the beginning where a spare field is available
or by prioritising available fields. This ensures that the required FAI numbers go with the pilot
scores when the Director’s report is submitted after the event.

2.4. Safety

For some clubs, launching and landing arrangements for a competition may not be too
different from their normal activity. However, for some, the arrangements for launching and
landing during a competition may require additional measures to be put in place to ensure
that flight safety is maintained.

This develops the local arrangements that were introduced during the pre-planning stage of
the competition organisation.

Launching and Safety

Launching any size of grid can be completed in a safe and timely manner if a well-organised
system is introduced, and practiced, by the organising team. Think about planning a visit to
another competition to see how they do it if your launch marshal team is inexperienced.

Common problems develop in the following conditions:

e Significant land-backs during a grid launch.

e Launch failure during grid launch.

¢ Re-grid following an abandonment of task.

e Launching of an alternative class to that gridded.

¢ Relighting gliders during the finishing of another class task.

Although it is difficult to foresee all scenarios, a pre-planning ‘desktop’ exercise to think
through potential problems can help ensure your launch team don’t get taken by surprise.

A common problem during launching is that of ensuring that the grid area is clear of
obstacles during launching, and afterwards if it will be an operational area following the
successful launching of the grid.

All airfield users should be made aware of competition arrangements so that the airfield
operations are not compromised at any point during the period of the competition.
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Finishing and Safety

All airfield users must be especially vigilant during finishing. The competition rules require
that the finish procedures are clear to competitors but it is recommended that this is also
communicated to all parties to ensure that finishing can be co-ordinated with other operations
occurring at the site. A ‘fail safe’ system should be utilized to prevent communication errors
occurring in any procedure that is developed locally to deal with ground and air operations. A
risk of an incident is increased significantly if procedures are not established for the following,
but not exhaustive, scenarios:

¢ Finishers that have lost radio communication with the finish line

e Finishers that use the wrong finish line

¢ Finishers that land on a non-active runway

¢ Finishers that finish in opposing directions to the normal operations

¢ Finishers that finish in a pre-briefed pattern which conflicts with current operations.

The finish line must be attended by two organisation officials: one responsible for
communicating, where necessary, with landing aircraft; the other responsible for ensuring
enforcement of a sterile area of the finishing line. The Rules additionally require that the
Director or his designated key officer monitor the finish to ensure that the conduct of flying is
continually observed. Staffing and briefing of finish line officials should reflect this
requirement.

A fail safe system should be in place to ensure that normal, abnormal and emergency
situations that occur at the airfield during finishing can be communicated via the finish line for
further action by the organisation or other airfield users.

Pilot Safety Committee (PSC)

The BGA Competition Rules require that each competition has a three-person Pilots’ Safety
Committee. (See section 5.1 of the Rulebook). The role of this group is to provide a peer-
group forum to promote safety and airmanship standards at the competition as well as
dealing with complaints arising from lapses in those standards without necessarily involving
the Organisation. The PSC should be made up of highly respected and experienced pilots
nominated by the Director or from the floor at the first briefing and elected by the pilots.

PSC Terms of Reference

e The PSC is empowered to investigate complaints about safety and/or flying standards
of all aircraft and pilots involved in the competition, including tugs and tug pilots, but
may, at their discretion, investigate and take action in the absence of a complaint,
when they judge that it is necessary to do so.

e The PSC has wide discretion in how it deals with issues and complaints but may give
verbal or written warnings to individuals where they consider it appropriate. This
would not normally involve the Organisation, or be brought to its attention.

o If, however, the PSC judges that an issue or complaint is particularly serious, or that
action by the Organisation is required, it may bring the matter to the attention of the
Director. In this case, the PSC may recommend that a competition penalty or
penalties be imposed. Such recommendation may or may not be acted upon by the
Director.
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e The PSC should not involve itself in any matter other than that related directly to
Safety and Flying standards.

Since the PSC is elected at the first briefing, at a time when they, along with the rest of the
competitors, quite naturally have their mind very much on other things they may not give
sufficient attention to the matter unless a safety issue actually arises. Directors are

therefore requested to make sure that, as early as possible in the competition, they meet with
the newly-elected PSC as a group in a quiet undisturbed location. At this meeting, the above
terms of reference should be run through to ensure that all members understand their role.

Since it is necessary that all pilots and PSC members alike are aware of these Terms of
Reference, Directors are also advised to publish them to all participating pilots in advance of
the competition and to display them prominently on a notice board during the competition

Directors must not regard the penalty that can be recommended by the PSC as one that they
must administer where no other suitable penalty is available. The penalty that the PSC may
recommend the Director to award must be as it says - “recommended” - and is intended for
application in cases where poor airmanship/dangerous flying is displayed to reporting pilots
despite previous advice from an earlier reported incident. The Director has full and final
responsibility to decide whether to actually administer the penalty if given a recommendation
to do so.
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2.5. Airfield

As with all airfield operations it is important to establish a safe environment for all people:
competitors, crews, organizers club members and visitors.

Airfield Boundary

The airfield boundary must be made clear to all relevant personnel (landowners and
members of the public) to ensure that air law requirements will be complied with during the
competition. The airfield boundary, for the purposes of the competition, must not be changed
without agreement from the Competition Committee.

Great care should be exercised in defining the boundary of the airfield taking the following
key factors into consideration:

e Legal status

e Landowners permission

o Airfield insurance cover

o Public safety (access and H&S)
e Aviation safety

Airfield Responsibility

The airfield operations remain the responsibility of the Chief Flying Instructor during the
competition but it is recommended that management control is clarified to all relevant people
before the competition to prevent any conflicts of interest occurring during the competition. It
may be necessary for the airfield responsibilities to be delegated to the competition director,
within a set terms of reference, for the duration of the competition.

If other club operations are occurring at the same time as the competition, the Director must
ensure that these are co-ordinated in a safe and efficient manner so as to prevent any
conflict with the safe running of the competition.

The club should ensure that normal club operations are managed to ensure the safe co-
ordination with the competition. It is recommended that Director, or a deputy, co-ordinates
with any instructor who has been delegated the task of running of the normal airfield
operations during the duration the competition. This should ensure that the safety aspects of
glider movements during the gridding process are not compromised.

Local Arrangements with Adjacent Airfields

Where adjacent airfields may be impacted by the competition the Director should ensure that
local arrangements are agreed before the competition and, where necessary, communicated
on a daily basis.

Airspace Mailing List

To ensure that airspace is co-ordinated on a daily basis it is recommended that an emailing
list is established so that daily tasks (printed in the agreed format) are circulated to all
interested parties as quickly as is practicable. This does not negate the need to follow the
requirements of any legal requirements set by the National Air Traffic Service (NATS). It is
recommended that the club advertises any additional services that it has implemented locally
and nationally to ensure that the information can be promulgated to as large a group as is
possible.
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2.6. Airspace

The pressure on airspace continues to increase, and our freedom to use what remains
available is under constant threat. It is vital therefore, that we are seen to use the airspace
with common sense and respect for others.

The Rules require the appointment of an Airspace Officer. This role should be given the
highest of prioritisation and support given the reputational risks of mis-identification of
airspace for task setting. A dedicated individual, fully conversant with airspace issues is an
absolute requirement.

BGA Contact
Directors should note that there is now a dedicated email address for the BGA Competition
Airspace Coordinator:- compairspace @gliding.co.uk

The ACN

The Airspace Coordination Notice (ACN) is a document issued by the Safety and Airspace
Regulation Group (SARG) of the CAA. it is created using the information you provided when
you made your competition application. It provides detailed information about your
competition and gives contact information. It is distributed to the BGA Competitions
Committee, The Competition Director, Military Low-Flying and Air Traffic Control authorities
as well as to interested parties and airfields in your geographical area about two weeks
before your event. Read it carefully, it may require the Director to take specific notification
action. It is also the trigger for the creation of your competition NOTAM, so is a vital
document.

Liaison

You should make every effort to comply with the Coordination Arrangements that are
specified in the ACN as rapidly as possible. This usually amounts to faxing (or emailing) your
intended task routes to the military addressees. As this information is used to generate the
military NOTAMS. The quicker you can get the information out the better. It is difficult to
provide task routes with the four hour notice required, but it should be possible to indicate the
likely task area in that timescale.

Publishing Tasks to The BGA Ladder “Showtask” page

As well as the information sent to the military, it is a requirement that task routes should be
published to the wider aviation community. This is done by uploading tasks to a special page
of the BGA ladder website, which is publicised by NOTAM and which can be viewed by
anyone who may be interested, Areas that are likely to have a high concentration of gliders
are naturally of interest to other users of class G airspace. By being aware of activity, pilots
can choose to avoid it.

The webpage concerned is http://www.bgaladder.co.uk/showtask.asp . This webpage aims
to show tasks being flown on a particular day that involve many gliders.

Tasks are loaded to the Showtask page by competition officials using the following link:
http://www.bgaladder.co.uk/logontask.asp. To enable you to logon to this page you need to
obtain a Password from John Bridge who administers the BGA ladder. John’s email address
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is johnb@aircross. Would Directors please make every effort to publish their tasks to this
page as soon as possible each day.

Please also continue to liaise with any other airspace users who may be affected by your
flying.

ATZs

There is evidence that unauthorized penetration of ATZs by gliders is increasing, with the
result that the good relationship that has existed between gliding and General Aviation is
being put at risk. It has not been thought necessary in the past to make ATZ'’s penalty areas,
since penetration in order to land has always been permitted. However, pilots should be
reminded that penetrating an ATZ without first obtaining permission (or making an attempt to
obtain information regarding penetration in the case of an airfield without ATC) is illegal and
must be avoided. Directors are reminded that they can make selected ATZ'’s penalty areas if
they judge it appropriate in their competition, but, in any case, should brief pilots not to make
any unauthorized penetration of ATZs except for reasons of flight safety. Task-setters should
also be sensitive to the possibility of ATZ infringements when routing tasks, especially
when the cruising altitude is likely to be low.

MATZs

Military Aerodrome Traffic Zones, not including the central ATZ (IE the 5nm radius zones
outside the central ATZ together with the associated stubs) have a different status in law to
that of civil ATZs which, in practice, means that they may legally be penetrated by GA traffic
without permission. (Note this does NOT apply to the standard 2 or 2.5nm radius ATZ at the
centre which must be treated as any other ATZ).

The consequences of a large number of gliders being in potential conflict with fast-moving
military traffic range from extremely expensive to extremely dangerous or both, so
competition organisers must take due note of the MATZs in their task areas and consider
whether the advantages outweigh the risks of tasking through the area.

If there is clear competition benefit in a task track going through a MATZ, Directors must
advise the appropriate military contact. Directors and Task-Setters are reminded that a list of
military contacts is available on the BGA website at :-
https://members.gliding.co.uk/library/pilot-briefing-airspace/military-flying-unit-contacts-june-
16/ and must ensure that MATZ operators are kept informed of potential glider traffic in or
near their zones. Pilots too must be briefed to avoid unnecessary incursions.

Radio Calls:- When in the vicinity of a MATZ, as with other areas of sensitive class G
airspace, pilots are encouraged to make their presence and intentions known by making a
radio call. Gliders fitted with transponders should turn them on. Competition organisers will
have informed the controlling authority of the possible presence of gliders, and will brief
competitors on whether group or individual calls are preferred. In any event, competitors
should monitor the MATZ frequency when approaching and arrange for those arriving in the
area first to call. Later arrivals can use their judgement. If in doubt, competitors should call.

Sensitive Areas in Class G Airspace

Concern is growing over the potential for conflict between gliding and General Aviation
arising from glider pilots and competition organisers being unaware of the need to liaise with
airfield operators in certain areas of class G airspace. Busy airfields which have ILS, for
instance, have the “ILS-feathers” marked on the air chart, but these were often disregarded
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by glider pilots and task-setters in the past. Certain airfield operators have expressed
concern at the number of gliders operating close to or within their ILS areas. The BGA is
keen to avoid more demand for controlled airspace from these airfields and seeks the help of
competition organisers in this. Directors and Task-setters are requested to be aware of this
issue and take steps to minimize conflict. If a task is routed close to such an area, for
instance, a telephone call in advance to the airfield concerned should be made. In addition
pilots should be briefed on such zones within the task area and encouraged to communicate
by radio with the airfield concerned should they find themselves potentially in conflict with ILS
traffic.

Class D Airspace

Gliders are excluded from Class ‘D’ Airspace unless special provision has been made i.e.
block exemption from the controlling authority. Otherwise all Class ‘D’ airspace should be
considered as inaccessible to competitors during the competition as there is a possibility that
whilst one competitor will be granted clearance to cross, another may not. In order therefore,
to maintain fairness, no competitor should fly within Class ‘D’ airspace.

Transponders

Now that transponders are required for flight above FL100 except when the requirements to
use “gliding sectors” can be met, BGA rules now define flight above FL100 as into forbidden
airspace except where the requirements of use of “gliding sectors” are met without the need
for a transponder. Where tasks are set near to these upper level “gliding sectors”, pilots
should be carefully briefed on this matter.

Prohibited Airspace

Task setters should not set task lines through prohibited airspace unless the lower ceiling for
that airspace is higher than 3500’ alt. Additionally, consideration should be given to not
setting task lines very near to any low airspace where the prevailing wind is likely to drift a
pilot into it if soaring conditions become unexpectedly difficult.

RA(T)s

Lessons learnt from the mass RA(T) infringement at Silverstone in 2010 indicated that, even
if there had been no infringement of the airspace by competing gliders, it is quite likely that
the display would have been curtailed simply due to the risk associated of having so many
uncontrolled aircraft so close to the display line in use. Therefore, it is vital that any task is
set a reasonable distance clear of any RA(T) during its active time phase — that should
include the track line associated with starting from the very extreme end of the start line and
should allow for a degree of track error and the likely influence of the wind direction if soaring
conditions become unexpectedly difficult.

Where an active RA(T) is very close to the event take off point and start point, serious
consideration should be given to not launching during that time period. It is possible that such
action might lose a contest day in extreme circumstances — however, as a repeat of the
Silverstone incident would have such serious repercussions for all UK glider pilots, this
should be regarded in extreme circumstances as a reasonable course of action.

Star-D (*D) Danger Areas

“Star-D” (*D) danger areas are special danger areas which contain airspace subject to
bylaws which are in force when the danger area is active. For this reason, unlike other
danger areas, all *D areas are permanent penalty areas (Rule 5.10.3). Where a *D danger
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area also has the § character prefix (e.g. 8*D208) this means that periods of activity may be
determined by contacting a nominated authority. If it is established by the competition
organiser that the area will not be active, it may be briefed as inactive and annotated as such
on task sheets. Otherwise it will still be a penalty area. Note, however, that other restrictions
may still apply and would have to be briefed, (for example, landings are still not permitted in
§*D208 even when it is not active, so extreme caution is advised before doing so.)

Nuclear Sites Restricted and Prohibited Area Exemptions

A dispensation is available to allow gliders to fly inside the restricted areas R101
(Aldermaston) R104 (Burghfield) and the Prohibited area P106 (Harwell), subject to the
following conditions.

1. Each site’s dispensation must be separately activated by the competition director by
contacting the nominated authority for each individual site and must have been
briefed as effective on the day.

2. Gliders must not fly within the areas bounded by the fences or in such a manner as to
cause a landing or crash inside the fenced area in the event of an accident.

3. This dispensation only applies to gliders with a glide angle of 30:1 or higher.

4. Normal air law applies in addition.

Rule 3 above suggests that the authorities do not want gliders landing inside the areas, even
outside the fences and, in the interests of the continuation of this concession, it is strongly
advised that pilots should avoid putting themselves in this position. However it is better to
land safely inside the circle rather than crash just outside it.

Penalties

The penalties associated with airspace infringement are simple and severe. This is to further
discourage the infringements that regrettably still occur — further details are posted in the
“penalty” section of this publication.

2.7. Distance Handicapped Tasks

In 2014, a new type of task format for handicapped competitions was made available for trial,
initially for use in Regionals and the Junior Championships. During 2014 and 2015 the new
format was used in several regional competitions and proved very popular. Distance
Handicapped tasks (DHTSs) are similar to standard fixed-course tasks in that all gliders fly to
the same turnpoints. The difference is that the radius of the turnpoint barrel (or “beer-can” as
it is sometimes known) increases as glider handicap decreases. Lower handicap gliders turn
earlier than high handicappers, so fly a shorter task. The barrel-sizes are calculated such
that, if everyone turns at the optimum point on the circumference of their barrel, all finishers
fly the same handicapped (and windicapped) distance.

This task format has a number of advantages over the standard fixed course task:
e Other things being equal, the time on task should be the same for all gliders, so
low-performance gliders don’t have to set off early and finish late. This negates

the disadvantage they usually suffer through having to use the poorer conditions
at the beginning and end of the day.
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e Shortest time on task wins, so if start times are accurate, day ranking becomes
obvious as soon as finishers arrive.

¢ Low handicappers can stay “in touch” with high handicappers throughout the race,
making it more fun for everyone.

e ltis suitable for task groups with a large handicap range

There are also some disadvantages:

¢ Windicapping affects barrel-size, so these tasks have to be set and scored using
a forecast contest wind, not one inferred afterwards from traces. Wind forecasts
tend to be fairly accurate, so this is not expected to be a serious problem.

e Accurate turnpoint capture in the air is difficult without using some form of GPS
navigation device, since, for most competitors there is unlikely to be a distinct
ground feature close enough to their target point on the barrel boundary. GPS
navigation devices are in universal use in competitions these days, so this is not
seen as a significant problem.

o These tasks are not suitable for helping pilots of low-handicap gliders gain badge
flights during a competition since they will not be turning close enough to declared
turnpoints. This is hardly a problem, but directors should be aware of it.

The Software

Each individual handicap requires its own turnpoint barrel radius to be calculated and each is
dependent on task length and wind-strength. This type of task has only become a practical
option for rated competitions due to the availability of special software. The software works
alongside SeeYou to offer organisers the means to set and score tasks of this kind with very
little impact on the processes already in place for the traditional task types. The Software is
free and can be downloaded from

http://www.boffins.co.uk/gliding

There are two modules, one for task-setting and one for scoring. Both have comprehensive
on-screen help and are easy to use. Note that the software is designed to work with SeeYou
and SeeYou Competition, but the version of SeeYou in use must be 5.44 or higher for all
features to work reliably. Naviter, the owner of SeeYou kindly makes temporary licences
available to competitions free on request, so this should not be a problem.

Competition organisers wishing to make use of these tasks are advised to download the
software and familiarise themselves with it as soon as possible. To help with training, the
software developers have published a set of videos. These are to be found in the videos

section of the Boffins website

Settings

The software is designed to support both BGA rated and informal club competitions. When
used in BGA rated competitions, the following settings should be used. (NB the following is
correct for V 2.1.7.0 of the Handicap Task Calculator program. Future versions may change)

Program Options, Defaults tab
Check the box marked “BGA Competition Defaults”.

Note that it is now possible to set “Showery Turnpoints” in DHT’s. Selecting the 90° Sector
Angle of the Variable TP Shape will automatically change the radius to 10km
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Set Checkpoint shape/size as desired, but make sure this is correctly depicted on the
SeeYou Task Sheet.

Setting Tips for Distance Handicapped Tasks

Track lines and actual turning points can be significant distances apart for gliders of widely
different handicaps, so task-setters need to take special care to ensure that gliders at one
extreme of the handicap range are not disadvantaged by having to negotiate airspace that
gliders at the other end of the range won’t encounter. For more detailed advice on this topic,
read Tim Scott’s excellent article on the subject published in the April/May 2016 issue of
Sailplane and Gliding and reproduced on the BGA website at
https://members.gliding.co.uk/library/information-for-organisers/handicap-distance-tasks/

Minimum Barrel Size

The default minimum barrel size for DHTs used in BGA rated competitions is 0.5km. This is
appropriate where the range of handicaps is wide, in order to keep the maximum barrel-size
down to a reasonable level. However, where the handicap range in a competition is narrow
enough to allow it, the minimum barrel-size can and should be set larger than 0.5km. This
will have the effect of improving fairness by increasing the size of the target for the high-
handicappers. It is also an alternative to the use of “Showery” turnpoints when showery
conditions raise the possibility of a TP being obliterated by weather. The latest version of the
DHT software will allow this even when “BGA Competition Defaults” is checked. Earlier
versions will need to have “BGA Competitions Defaults” unchecked, in which case the other
standard BGA parameter values will have to be selected.

Briefing The Tasks

Since this is still a new task format, not all pilots will be familiar with it. It is imperative that all
pilots should be thoroughly briefed. The concept is relatively simple and should not present
too many problems for pilots, but the format does imply a change of tactics and, for the sake
of fair play, pilots should be given the time to think through the implications and to ask
questions. Don’t spring it on them on day one. Ideally pre-announce your intention to use
this type of task in the Local Rules and, if you plan to set one on day one, try to lay on a
briefing session on the previous evening. It needn’t be lengthy, but the following points must
be made clear to all pilots:

e Your barrel size is fixed and unigue to your handicap, for all but control points, in
each task.

o Every new task, including alternates on the same day, will mean a different barrel-
size for you.

e Make sure you know your barrel-size and the radius of any control points for the task
you will be flying before you launch.

A feature of these tasks is that, apart from control points, all turnpoint barrels for a given
handicap on a given task are the same size and are circular. This means that they can be
flown by pilots with the bare minimum of navigation avionics. A hand-held GPS would do.
Pilots can, of course, set up their moving map instruments with the exact observation zone
geometry, but those without the equipment or the skill can simply monitor their distance from
the nominated TP and turn once it indicates they are inside the barrel. This may be obvious,
but it should be pointed out at briefing.
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Alternate and Fallback Tasks

Barrel sizes are unique to each task. Directors must ensure that the standard Tasksheet as
specified in the Rules, together with the task reports from the special software (which shows
the task turnpoints and the list of handicaps and barrel-sizes) are attached to each other
when distributed to pilots, or better still, printed on two sides of the same sheet. Alternate
tasks and Fallbacks can be very similar to each other, so Directors are also advised to
include an independent check of all briefing documents before distribution to ensure that the
correct barrel-sizes are always attached to the task sheet. A task flown by the whole field
with the wrong barrel-sizes would be almost impossible to score fairly, resulting in a non-
comp day if it were to happen.

While creating fall-back tasks in Distance Handicapped tasks by asking pilots simply to drop
a few handicap places may be fine for club use of this type of task, it is not acceptable in a
rated competition. Separate fall-back tasks should always be used.

Task Sheets

Although it is possible to create individual task sheets for each handicap with the correct
barrel-size shown on the map, this is obviously impractical in a competition. It is
recommended that the task map shown on the SeeYou task sheet should be created using a
standard barrel size of 5km (or the maximum barrel-size if less than 5km). This should make
it easier for everyone to estimate the size of their own barrel. The sector associated with the
barrel, which will be of more relevance to the higher handicappers will then always be visible.

2.8. Task-Setting (all task types)

Task setting is all about planning the task length and shape to optimise the opportunities on
a given day. In the United Kingdom, with its myriad airspace arrangements, challenging
weather conditions and sometimes short soaring ‘windows’, this role should not be
underestimated.

Getting the right balance for the appropriate task needs to consider pilot ability, range of
glider handicaps (where applicable) and airspace density and timings. The seriousness of
potential airspace infringements, from a reputational perspective, should be considered at all
times when designing tasks on any particular day.

A good task should give all competitors a fair race with a minimum of luck and guesswork.
Whilst it is undesirable to ‘waste’ a good day by under-setting the task, you should also
attempt not to over-set - making it impossible for competitors to finish. This is particularly true
when it only affects the pilots flying lower performance aircratft..

Attempting to set tasks to generate a 1000 point day only for the day to become ‘devalued’ is
misguided. If the weather conditions dictate a short task length of 150km, then this is what
should be set. It would be better for all concerned if a shorter task is chosen, thus allowing
the pilot some flexibility on start time, and still race in reasonable conditions using most of the
available day. Please bear in mind that you’re unlikely to get disgruntled Regional’s pilots’
who complete a fast 300km, but you will if they fail a struggling 400km!
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With that in mind, tasks should be designed not to maximise the distance flown on a
particular day but to establish, by the end of the competition, that the winner is the fastest
pilot. However, where soaring and a successful grid launch can be guaranteed by mid to
late morning, a longer task should not be ruled out.

The key to setting a good task is to establish what the meteorology information suggests is
the ‘rough area’ where the task should be best set and what the ‘length’ of the soaring day is.

This should be done at the earliest opportunity on a particular day; although options may be
forming 24-48 hours before.

The next action is to decide what type of task is required. There are two long-established
course types: Fixed Course and Assigned Area. In 2014 a new type of task was introduced
which may be used in Regional competitions and the Junior Championships only. This new
task type, known as “Distance Handicapped” uses a turnpoint barrel radius that increases as
the glider handicap reduces in such a way that every finisher will have flown the same
handicapped (and windicapped) distance. See the article on this task type in section 2.7.

The definitive rules for all task types can be found in section 5.7 of the Rulebook.

Assigned Area tasks are intended to allow competitors the opportunity to make the best use
of soaring conditions and should be set only when good uniform soaring conditions are
forecast across the whole task area to avoid the results being unduly influenced by luck.

The AAT task is a valuable test of skill for pilots in uniform conditions but care should be
taken to ensure that the design is carefully thought out and limits the degree of chance that
can be created with the setting of this type of task. AATs can be a good option when there is
a large variation in glider handicaps and can also make a welcome change from fixed course
tasks.

In general, where conditions are unlikely to be uniform, a fixed course or Distance
Handicapped task should be set

Some pointers for setting the task are as follows:

a) Check the met forecast and discuss this with your ‘Met man’ at the earliest
opportunity.

Decide the rough area where the task should be set and also the best finish direction
given forecasted wind. At this point you may have decided what type of task
(AAT/Fixed Course/Distance Handicapped) is appropriate.

b) Establish the Permanent and Temporary Airspace that will impact on the task.

In most cases the airspace identified the night before may have not significantly
changed but re-confirm what temporary airspace may impact the task before starting
task planning. Where a significant temporary airspace is present, such as a RA(T),
then it may mean compromising the task to an area where the weather is not as
good.
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c) Decide when the start line is likely to open.

This will be approximately an hour after the first launch. First launch depends on how
the day develops but may be delayed by the requirement for briefings, getting
everyone on the grid, and the inevitable other delays that may occur due to weather.
On the first flying day of a competition there are the additional risks of delays due to
pilots being unready and also potential organisational issues such as grid launching.

d) Decide when the pilots need to finish by.

Does the met man envisage the day continuing into the evening or shutting down
early for any reason? Is any weather arriving to spoil the day? This, of course,
comes with experience but where thermal strengths are likely to deteriorate due to
top cover approaching from a warm front then it useful to consider this issue, in
combination, with any significant head wind that might impede progress on the later
stages of the task.

e) Estimate the achievable XC speed taking into account glider and pilot performance.

This will be based on thermal strength and cloudbase but must also allow for positive
factors such as streeting and negative factors such as spreadout.

The combination of available task time and predicted XC speed gives an estimate for
the potential task distances achievable. For fixed course tasks, this calculation
should be based on the slower pilots in the lower performance aircraft With AATs
and Distance Handicapped tasks, lower handicappers will not be required to fly the
same distances as the high-handicappers and this can be taken into account.

f) Decide Distances and Task Shape

From your rough estimation of achievable task distance you should be able to design
a task within your task setting programme that can be shaped to coincide with the
area where the best weather is likely to be available.

The available task area and the desired task length will influence the overall task
shape and whether the task has to be folded to fit (creating ‘arrow’ or ‘bow-tie’ shaped
tasks). If the wind is strong then consider predominantly up and down wind. Running
streets is fun but struggling crosswind can be demoralising. Inbound and outbound
tracks at turning points should be separated where possible as lookout may be
compromised close to turning points.

Excessive numbers of turning points should be avoided although it will sometimes be
necessary to add control points to ensure adequate clearance from airspace. Don’t
make the mistake of trying to use standard turnpoint types as control points in an
AAT. All zones in an AAT, however small, will be scored as areas (IE the distance
flown inside them will count) so even control points must be flown as such. You may
want to emphasise this point during briefing.

In general, when setting Fixed Course tasks or Distance Handicapped tasks, 2 or 3
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turning points will be adequate unless weather and airspace require additional control
points to ‘fold’ the task into the available soarable window.

Take particular care to avoid setting task legs close to very low airspace where the
prevailing wind may encourage pilots to get pinned against the airspace boundary
when conditions are unexpectedly poor thus encouraging accidental infringements.

Fall-Back Tasks

A number of fall-back tasks should also be set just in case the day does not develop quite as
predicted. It is preferred that this is done without significantly changing the shape of the task
by using turning points that are close to the original task line. When using this approach be
careful that this does not result in task lines becoming closer to ATZ and Parachute Drop
Zones.

To minimise planning and pilot stress it is often possible to do this by changing or removing
one turning point of the original task at a time. This approach can also minimise the work
involved when multiple classes are being tasked simultaneously as fall-back tasks for one
group can become primary tasks for another.

It is recommended that fall-back Fixed Course or Distance Handicapped tasks are set that
are incrementally reduced in length to take into account of delays in launching the grid.
Every V2 hour delay, from primary task ‘window’ is approximately equivalent to 30-50kms of
task length. This can be done similarly for AATs but reducing the time on task by ¥ hour
increments.

When considering fall-back options for Distance Handicapped Tasks, it may be tempting to
ask pilots to simply drop down a few handicap places rather than issue a new task. While
adequate for club use of this task type, this is not acceptable in a rated competition as it will
introduce additional approximation errors and scoring will be unreliable.

Enhanced Option “Showery” Turnpoint

If showers are considered more than likely you should use the enhanced turning point option
in your Fixed Course or Distance Handicapped task. The “enhanced option” turnpoint
design has the normal 90 degree 20km sector behind the 0.5km radius extended to 180
degrees but reduced in radius to 10km. This effectively creates a huge opportunity to gain
control at a TP and gives a viable alternative to entering the 500m radius of the conventional
TP in showery conditions. Please note that, in fixed-course tasks, the 500m radius still exists
in this new format and flying to these will always represent the shortest task length, even if
the 180° sectors overlap. In DHT’s, the barrel size is as briefed.

When using this type of TP no benefit is accrued for any extra distance flown as it would be
in an AAT. A task set with Enhanced Option turn points replaces the alternative TP tasks that
used to be set in showery conditions before AATs became available and then subsequently
used by default. It is intended that tasks with enhanced option TPs are used for flights where
organised showers are forecast. It is recommended that normal TPs are used when shower
activity is forecast to be occasional only.

See You and Task Sheet
By this stage, the task setter has defined the task area, the task length and the finish
direction. It is time to fire up a task setting program and start creating the task sheet. It is
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important that See You is set up before the competition begins with current airspace
information and the current competition turning-point list. It may be useful to add templates
for different task types, turning point types and finish line directions. This makes the design
of the task on a particular day relatively straightforward and takes away the potential for
introducing errors.

It is also advisable to add any temporary airspace for the day. This will enable tasks to be
set more readily with reasonable separation of turning points and track lines from airspace
boundaries.

Once the primary and fall-back tasks have been selected, it is important that they are
reviewed by someone who has not been involved in the task setting process. This provides
a sanity check and should especially check for any problems with airspace. The Director
may wish to do this.

The format for the task sheet is now set out in the Competition Rules and an example of the
required output is provided in Part 4 of this document including some guidance on how to
create them in See You.

It is important that the information provided on the task sheet is accurate and in the format
required by the BGA. In particular the following points should be checked:

e Task designation is explicitly clear.

e Turning point tri-graphs and co-ordinates are provided as per the format in BGA
turning point list.

e The observational style description is included (see example). It is not recommended
to attempt to provide additional information on bisector angles that are not
automatically calculated by See You.

o All temporary airspace, and ATZ information, is laid out as required by the BGA rules.

By creating a standard format task sheet, it is hoped that the much heard pilot question of “Is
it a penalty zone?” will become one from the past!

In most cases the Task Sheet can be on one piece of double-sided A4 paper but where
additional tasks are required this may require additional task sheets to be produced. Note
that with Distance Handicapped tasks, a separate sheet with barrel sizes for each handicap
will probably be required in any case.

Where there is any doubt on the weather, and task shape/length, it is best to delay briefing
until the most appropriate task can be configured. Attempting to rush a task to meet a
briefing deadline could ultimately end up in the best task for the day being missed or, worse
still, the day being scrubbed.

As the day develops, the task setter, in dialogue with the Director and Met-Man, should
review the tasks and select the appropriate one for the conditions. This may be the primary
task, one of the fall-back tasks or a totally different task which is subject to a briefing at the
front of the grid. Briefing on a new task at the front of the grid brings on a number of other
challenges, and risks that should be carefully thought through before taking forward.

At the end of the day it is useful to the task setter to discuss the day’s task with the pilots so
that lessons can be learned for the rest of the competition.
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2.9. Daily Briefing

The daily briefing and the use of task sheets is the only way of ensuring that the pilots have
the correct information for the task that they fly. The organisation of the task, bringing
together task design, airspace co-ordination and meteorology information should not be
spoilt by a poorly provided brief and task sheet.

Pilots are reliant on that information being correct not only to provide a valid flight but to
ensure that flight safety is not compromised.

Section 5.2.2 of the Rules identifies the minimum content that must be provided at daily task
briefings including the minimum content and standardised format for task sheets. See the
reference section for detail on the creation of task-sheets.

Critically important is the requirement to brief Airspace restrictions, exemptions and hazards
that might affect competitors and are additional to those shown on the latest aviation maps,
i.e. deemed active parachute zones to be treated as prohibited airspace, Temporary
Restricted or Prohibited airspace and advisory navigation warnings issued by NOTAM.

Where an additional airspace restriction is in force and hence briefed and there is a
possibility that tasking could take a pilot close to such airspace, the organisation should
provide sufficient detail to allow pilots to create electronic files for their navigational
instruments. You should consider providing this detail where known at the beginning of the
competition. If this is not possible and the additional airspace design is not a simple circle,
tasks should not be set where there is any realistic likelihood that such additional airspace
may be infringed.

Pilots entering a BGA rated event should be fully conversant with the normal airspace in the
task area as published and in force all the time as described on a current %2 million aviation
map. It is always helpful to amplify this knowledge by verbally briefing the various standard
airspace considerations in the area likely to be flown in on each of the designated tasks.
However, contest organisers have a duty of care and must fully advise pilots giving
appropriate detail of any additional prohibited airspace notified by NOTAM that may be
encountered on task. It is not realistically possible in a contest situation for the pilots to
discharge their legal responsibility to check all NOTAMs themselves so they are rightly reliant
on the organisation for a full and unambiguous briefing of such temporary additional
restricted or prohibited airspace.

See the reference section for details of minimum content for task sheets.
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2.10. Met Briefing

Met forecasting is essential for task-setting. However, it is also essential information for pilots
if they are to make the best of the day.

Minimum weather information such as wind speed and direction, cloudbase, thermal strength
and expected cut-off time, etc should always be provided at morning briefings. Best-practice,
however, recognizes that a pilot who has a good grasp of the synoptic situation is better-
equipped to make tactical decisions when faced with changing weather in the task-area and
this is one of the key skills that separate champions from also-rans. For this reason,
organisers should make every effort to lay-on as high a standard of met briefing for the pilots
as they are able.

A qualified aviation meteorologist on the team is, of course, the gold-standard. However, with
the excellent met information available on the internet nowadays, it is not at all necessary to
have a meteorologist (amateur or otherwise) on-hand to be able to deliver a high-standard of
met briefing.

Many pilots are quite capable of self-briefing to an acceptable standard using these modern
tools and this will be true of many of your competitors, but it is often difficult to do this
effectively in a competition environment, so a briefing to at least the same standard should
be given.

As a minimum, the organisation should seek to prepare a short presentation each day
containing the information that such a self-briefing pilot would normally use.

Here are some commonly-used internet sources:

The Met Office

http://www.metoffice.gov.uk/ This is a free general service

http://www.metoffice.gov.uk/aviation/ga This is the Aviation service and is free to
reaqistered users. Reaqistration is free.

Rasp

http://rasp.inn.leedsmet.ac.uk/ This is a free service

Top Meteo

http://www.topmeteo.eu This is a subscription service requiring a

login
Gliding-Club Forecasters from their respective websites:
http://www.lashamweather.co.uk

http://www.londonglidingclub.co.uk/forecast.xml
http://www.bggc.co.uk/index.php/weather/sid-s-forecast
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2.11. General Communications

Good communication with everyone at your competition is essential. Competitive fairness
goes out of the window the moment any pilot fails to receive information that he or she needs
for the competition and everyone’s enjoyment is threatened when stress-levels go up due to
poor communication.

The trick here is belt and braces. Never rely on a single medium for delivering a message.

Key Competition Communications:

e Grid Order: Handed out at initial briefing and Posted on Notice Boards

e Grid Before Briefing: On Main Notice Board, On website, By Text Message

o Briefing Time: In Local Rules Changes advised by Notice Board, on Website,
by Text

e Earliest Ist Launch Announced at briefing. Changes on PA, Competition
Frequency Airband, Text Message.
e Rebrief Announce on PA, Airband, Text Message

2.12. Competition Radio

Radio Communications can be largely be split into 3 areas: organisation, competitor/crews,
and other airfield users.

To ensure efficient transmission of communication to all key organisational staff, it is
recommended that ground to ground and ground to air radios are used. Where possible,
separate frequencies should be established to ensure that clarity is maintained in normal,
abnormal and emergency operations.

Radio frequencies for communication with tugs, competitors, and other airfield-based gliders
should be established beforehand so that conflicts with other competitions and other gliding
operations are avoided and so that key safety messages can be communicated to all
relevant aircraft expeditiously.

Equipment

It is essential that gliders in the air are able to receive clear readable transmissions from the
organisation on the ground. Start and finish radio communication is best carried out using a
base-station with a decent aerial, rather than less powerful hand-held radios. It is good
practice to site the equipment in or near the control centre.
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2.13. Gridding

The Purpose of Forming a Grid

To minimise the role of chance in the competition, it is important that the entire field should
be launched within the minimum time and that launching should start exactly when the
Director intends and be completed as quickly as possible. It is also important that gliders are
launched in the order required by the rules. Mustering the gliders together in a grid at the
launch point makes all of this possible.

Grid Order

Grid order determines launch order. Pilots must be informed well in advance what their grid
order for the day is. The usual practice is to allocate gliders to a “Cone Number” and move
the numbered cones, marking the position of each row from day to day. The glider always
aligns with the same cone number. This lets the grid form automatically in the right place and
in the right order without help from the marshals once the cones have been set out.

The Shape of the Grid

The shape of the grid (how many rows and columns) will be determined to some extent by
size of the airfield and the launch area. However you do it, leave access lanes between
columns to allow later-arrivals to reach their allocated row and to allow pilots who refuse a
launch (before the grid is compressed) to extract their glider and get to the back of the grid or
the designated relight area..

Heavy Column

If you have a mixed-class field containing some large gliders and only a few powerful tugs,
consider designating one of the columns for the heavies. That should help spread them out
through the launch sequence and, with luck, you will always have a heavy glider available
when your powerful tugs arrive.

Grid Before Briefing

On good days, you will want to launch as early as conditions allow. In this case the cone
system, coupled with access lanes, really comes into its own, letting the pilots grid any time
before briefing. It is essential that GBB is communicated to pilots as early in the day as
possible. The competition notice board, the website and text messaging are ideal for this. An
announcement on the PA system should also be considered at breakfast time.

Grid Marshals

It takes a lot of effort to get a large number of gliders assembled at their appointed places
and launched without delay. The launch rate with a large grid can be intense and a team of
people who know what they are doing is essential if this is to be accomplished. It is good
practice to have grid marshals identifiable by the use of high-visibility vests. This lets
everyone else know who they are and lets them spot each other amid the throng of crews
and onlookers. It does not take many good grid marshals to run an efficient grid. The key is
that they should work as a team under the direction of a single individual.

Equipment

Not much is needed, but a few short ropes with rings for release-checks are essential as are
rope-hooks. With rope hooks, two marshals working together can bring the rings from a
waiting tug to the nose of a glider ten times faster than a single person on their own can do
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it. Shaving seconds off each launch is as valuable as fast-climbing tugs when it comes to
getting a large grid launched in under the hour.

Self-Launchers

Self-launchers can usually be incorporated into the grid and allowed to launch direct from
their grid position. If you are short of runway, however, and your launch area permits it, you
might want to consider sending heavy self-launchers off (in proper order) from an area off
grid, and as far back as possible. This approach might also be considered if self-launcher
slipstream is a concern.

Compressing the Grid

On all but the largest of airfields you may want to maximise the available length of take-off
run. This can be achieved by compressing the grid from front to back shortly before the
launching commences. Cars and equipment should be moved out of the way and gliders
rolled back so they are nose to tail. Note that once this is done, any late arrivals on the grid
will have lost their opportunity to take their place and will have to be treated as if they have
refused a launch. Also any pilots wishing to refuse a launch will be unable to get out of the
grid and moving them out during the launch sequence could be disruptive, so compressing
the grid should be left as late as possible.

Managing “Grid Squats”

If the weather does not cooperate, an opportunity to launch may not occur until later in the
day or, even, not at all. This could mean waiting on the grid for an extended period. If
launching is to be delayed, it is imperative that pilots are kept informed. The time for the
earliest possible first launch should be kept under constant review and communicated to the
pilots. Announced slippages should be long enough to be worth announcing but not so long
as to run the risk of missing a favourable opportunity. Once announced, a slippage must not
be revoked and whatever happens, pilots must not be put in the position of being rushed into
an unexpected launch. Good practise is to keep to announced times and to give ten and five
minute warnings. A portable PA system for use on the grid can be invaluable here.
Announcements should be backed up on air band as many pilots will be close to their gliders
with their radios switched on. Announcements of new earliest launch times should also be
made on the public PA system in the communal areas.

If the grid-squat has been going on for an extended period, consideration should be given to
standing down for comfort breaks and/or lunch.
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2.14. The Decision to Launch

When conditions are good, you can’t go far wrong launching as soon as it becomes soarable.
During the time between first take-off and opening the start line, conditions are likely to have
improved and getting the start line open as early as possible will probably be sensible. In any
case pilots always have the option of making a later start if they wish.

When conditions are marginal or rapidly changing, launching too soon could result in mass
relights, but launching too late could mean missing a useable window.

Competition pilots will generally trust the Director’s decision to attempt the task, so the
Director has a responsibility not to launch until there is a reasonable prospect of completing
it. Likewise the Director has a duty not to launch if weather conditions are, or are likely to
become, hazardous.

The Sniffer

On any day, the sniffer is the Director’s first opportunity to find out whether conditions are
developing as expected. A good sniffer can be an invaluable aid to the Director in making the
decision to launch.

Make sure the sniffer pilot understands what is required, i.e. clear factual reports of the
conditions (achieved average climb rate, cloudbase, visibility, wind at flying heights). Over-
enthusiastic reports and personal opinions are not wanted.

In difficult or rapidly-changing conditions a turbo-equipped glider can be particularly useful as
a sniffer. If you have a choice, a sniffer with wing-loading similar to the competing gliders is
also beneficial.

Rebriefing

If conditions dictate, it may become necessary to switch to a fall-back task. If this is one
which was briefed earlier as one of a set of alternatives, the briefing should consist simply of
informing pilots of the change and ensuring that all pilots are aware by using a re-brief
checklist at least 15 minutes before launch. On the other hand, if a completely new task is to
be briefed, extra care should be taken. The new task will have been created in response to
unexpected conditions and it may well have been created in a hurry. Extra care must be
taken to ensure that the new task meets the required standards and that proper task sheets
are produced. The rules require a minimum of 30 minutes before launch in this case.

It is general practise to call the pilots together in a group on the grid to carry out these re-
briefings. It is then easier to ensure that all pilots have the information, but it also promotes
fairness since it allows clarifications and answers to questions to be heard by all. As well as
the new task, pilots should also be told the reasons for the decision. New information about
incoming weather, for instance, may be of value.
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2.15. Launching

The Role of the Launchmaster

It is important that the launch phase is carried out under the direction of a single individual
who is conversant with all aspects of tug and glider operations and is capable of directing
tugs by radio to avoid conflicts in the air and on the ground. Tugs on the ground will have to
be directed to their next customer and grid marshals will have to know which tug is being
directed to which glider and which will be next to roll. It is not uncommon for two or more
tug/glider combinations to be hooked up and ready to take up slack at the same time.
Obviously no-one should be in any doubt as to which is to go first, especially the tug pilots.
During the launch phase, the launchmaster alone is in charge.

Helpers

As with any glider launching operation, only helpers who know what they are doing should be
allowed to attach ropes and run with wings. Generally these tasks should be carried out only
by grid marshals or the recognised crew of the glider being launched.

Pilots’ Option to Refuse a Launch

Any pilot may refuse a launch when offered in normal grid order. Pilots who do so must then
use the relight procedure to launch. In practise, pilots taking this option will often position
their gliders in the relight area without being directed to. The decision to refuse a launch may
be made at any time, even after launching has started and grid marshals will need to be
ready to help move the glider out of the way quickly to minimise disruption.

Launch-Logging
Don’t forget to make a record of launches. Glider Ident, Tug Ident and Time are all that is
required. This information will almost certainly be required later by someone.

Last Grid Launch

The earliest time that the start line can be opened is based on the time that the last
competitor had the option to launch. Gliders which have been moved voluntarily to the relight
area have had the option, but have chosen not exercise it, so they do not count for this
purpose. If the relight area is at the back of the grid (which is often the case in single-class
competitions) it will not be obvious where the grid finishes and the relight area starts. Don’t
make the mistake of counting these gliders. Make sure you work from the time that the last
glider not to have refused a launch is launched.

Moving the Drop Zone

The Director may change the drop zone whist launching if those about to be towed will be at
a sporting disadvantage to those previously launched. A good example would be a rain
shower in the drop zone or if it's generally unsoarable in the drop zone after having been
suitable earlier in the launch sequence — you can brief the tow planes to tow to a different
area if necessary.

Relights

Gliders may land back even during the launch phase so, if space on the airfield permits, it is
both safer and less disruptive to brief a landing area for relights which will not interfere with
normal launching. It may also be practical to designate a relight launch area away from the
grid. Moving landed gliders from the landing area to the relight launch area should not be
allowed to interfere with normal grid launches although, in multi-class competitions, provision
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should be made to comply with the rule which requires relights from an earlier class launch to
be merged with those of a later class. Provision should also be made for immediate relight
where the failure to launch successfully was no fault of the pilot or crew.

2.16. Starting

Start Procedure

The start procedure has been adjusted over the years to try to facilitate the safest set of
conditions at the start where, inevitably, there is a high glider density and resultant collision
risk. In order to discourage the practice of circling extremely close to or in cloud resulting in
reduced conspicuity, recent past measures sought to set a start height well below cloud and
defined as the start gate opened. As a result, dive starting became prevalent. This was
deemed very dangerous as gliders were diving and pulling up whilst others were circling
slowly in the start area. This was subsequently outlawed with the implementation of the “5
minute” rule, later adjusted to the “2 minute” rule (stay below start height for two minutes
prior to starting).

Feedback from pilots, both in the UK and in international FAI competitions, where the 2
minute rule was being used suggested that the requirement to monitor altitude, position and
time in a busy environment where gliders are both ascending and descending to the height
limit, produced a workload that was just too high and gave a significant temptation to
prioritise the viewing of instrumentation rather than the visual traffic.

Therefore the procedure was changed in 2010. Now, there is effectively no limit to the start
height other than an absolute limit set an amount above cloud base to discourage the
advantage that might be gained from a fortuitous wave climb prior to starting if this can be
achieved while staying clear of cloud. This means that it is NOT necessary for pilots to
monitor height or time, meaning that they are free to look out and there should be no gliders
descending down to height in the start thermals.

This procedure quite clearly has many advantages in that pilots can be fully focused on
looking out for traffic. However, no specific measures other than good airmanship practices
prevent the dangerous practice of flying in restricted visibility around and in the base of cloud
in the vicinity of the start point, which was a contributing factor to a fatal collision that
occurred some years ago. The Competitions Committee believes the current procedure to
be, on balance, the safest and easiest for pilots but good airmanship does need to be
promoted to prevent heightened risk if a pilot were to fly in severely restricted visibility. It is
recommended that, at the beginning of the competition, the risks associated with all aspects
of the event, including the start procedure and the airmanship required, should be discussed
at briefing and refreshed throughout the event - in particular the significance of the
requirement that “Pilots must remain clear of cloud and in full visibility of all gliders in the
same thermal when within 10km of any start zone and base airfield reference point”. Please
encourage pilots to use the Pilot Safety Committee if they think fellow competitors are being
irresponsible.

Please also note the total cloud flying restriction that is placed on flight prior to starting (pilots
first or last start).
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2.17. Task Cancellation

The Director may hold the start-line, ‘scrub’ the task prior to the start line opening, and/or re-
task. Should a re-task be considered necessary, all competing gliders must be recalled, and
a single radio transmission should be all that is required. Once all gliders have landed back
the task may be re-briefed and a new grid established.

The Director must however, allow at least one hour between the recall and the first launch to
allow pilots to return safely and to re-plan the task. Any competing glider that has landed out
prior to the start-line opening will not be eligible for a launch on the subsequent task.

The Director may also re-task if, after the start-line has opened, all competing gliders land
back without starting.

On a number of occasions in recent years, a day was ‘scrubbed’ which subsequently turned
out to have been a possible contest day. Bear in mind that at mid-summer, it is not unheard
of for it to be soarable at 8.00 pm. This could allow a class to be launched on a moderate
task as late as 4.00 or 4.30 pm. Please do not be tempted to ‘scrub’ too early. It is better to
have restless pilots waiting to launch than angry pilots deprived of a reasonable afternoon
contest.

2.18. Finishing

Finishing Procedures

Following the tragic accident at Husbands Bosworth during the 2005 Junior World Gliding
Championship, it is increasingly clear that flying conduct during the finish continues to require
careful consideration to ensure safe procedures are implemented and should be fully
monitored to ensure that these procedures are being followed. Since 2006, the rule book
implemented procedures and a penalty structure for dangerous flying that sought to ensure
the protection of people and property outside the airfield. Apart from a duty of care to ensure
that people and property outside the airfield boundary are protected, the CAA are keen to
assure that glider pilots observe the Law, namely the UK implementation of SERA
(Standardised European Rules of the Air) and its associated UK exceptions regarding low-
flying and reckless or negligent endangerment of any person or property.

It is useful to highlight what the requirements actually are and how they are interpreted at this
time by current BGA thinking.

The law on reckless or negligent endangerment is a “cover all” statement of Law that
requires that pilots do not endanger people or property. There are no specifications on how
to meet this requirement.

The low flying law in context to finishing requires that glider pilots may not fly within 500’ of
people, vessels and property unless protected by the exemption of being in the process of
the procedure of landing in accordance with normal aviation practice. Normal Aviation
practice means different things depending on whether you are, for example, a commercial
airline, helicopter, or glider pilot. Following discussion with the CAA, the BGA view is that
glider pilots whether competing or flying standard circuits will meet the requirement of
exemption provided that they exhibit a descending glide profile keeping the landing area in
view at all times and in the case of a competition final glide, where a direct landing is a viable
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option. The CAA and BGA are content with the need in many instances to ultimately find it
necessary to pull up and go around for an abbreviated circuit, for example, where the pilot
has a gross excess of energy or the landing area is obstructed or for any other flight safety
reason. However, there is a basic need to have a viable direct landing option to be able to
claim the required exemption.

In the context of finishing and the close proximity to the ground in the final part of final glide
to landing, it is clear that a minimum height rule may only be broken without penalty on the
grounds of flight safety (including extreme low energy that may lead to landing short) and is
appropriate to eliminate the possibility of danger to members of the public. This minimum
height is set at 30’ above ground level and any structure, including inside the airfield
boundary where people require the very same protection from danger. Furthermore,
adherence to BGA best practices of a descending flight path and retain sight of the landing
area when below 500’ is required. However, it is acceptable to pull up to change from a direct
landing to an abbreviated circuit pattern.

With the necessity to offer a viable direct landing option, it is a requirement for the
organisation to arrange the finish line in such a way that it is orientated from between 0-30
degrees to the perpendicular of the inbound track line and situated such that gliders can
safely land directly beyond it without turning. Positioning of the finish line and inbound track
to it should take into account any potential conflict with any person, vehicle or structure on
the approach to and around the finish line and should normally be placed near the runway
threshold to maximise the safe landing area beyond. A Control Point should be utilised as
necessary to ensure compliance to the above. It is recommended that such a control point be
ideally no closer than approx. 10km so that the pilot is not pre-occupied with landing
considerations whilst trying to satisfactorily round the turn point. Where the normal task line
approaches the finish line at an appropriate angle already, a further control point is not
necessary unless it is felt wise to promote an exact finish path to avoid approach hazards
such as built up areas etc. In this case, a control point is again a recommended option. If
suitable control points are not available in the BGA list then organisers should develop their
own control points and publish the co-ordinates in the local rules.

It remains a requirement for the organisation to specify and use an additional specific officer
with responsibility to share the observation of the conduct of finishing gliders with the Contest
Director and to monitor any public activity close to the airfield boundary, which might pose a
danger to the pilots and themselves. This officer may carry out other duties and
responsibilities.

In the 2013 Rules, the definition of the Finish Ring option was developed to allow its use as
required without further specific approval as before.

The finish ring is intended to provide a deceleration zone after finishing giving more time for
pilots to organize their landings. However, it must be noted that the final leg must still be
orientated roughly(within 30 degrees) with a viable landing direction forming part of the
landing procedure in force at the time. Otherwise it does not readily meet the requirements
for pilots to meet the low-flying regulations.

The size of the ring must be specified (normally 3km) along with a minimum altitude which
should be as low as possible whilst meeting the Rule requirement. Setting the minimum
height too high results in increased pilot work load and risk with maneuvering gliders.
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Within the penalty section of the Rules, the penalty for crossing the finish ring below the
required altitude has been specified. Directors are reminded that when using this finish
method they must be prepared to routinely monitor pilots’ flight recorder records for height
compliance.

The CAA has made it known that they will continue monitoring our events to ensure
compliance to the BGA Rules and the Law. So please make sure that every effort is made to
continue to encourage safe flying practices by careful consideration of the finishing
procedures and continual monitoring of compliance. A clear transgression observed by the
CAA may well lead to them taking a draconian view rather than its current standpoint of
tolerance to our needs.

2.19. Scoring

As with all competitions, it is important that the scoring, together with any necessary
penalties, are applied in a consistent and transparent way.

The following provides some guidance and suggestions for using SeeYou Competition to
score BGA-rated competitions.

They cover key points that the scorer should observe, but are not intended to be a
comprehensive ‘how to’ guide, and should be used in conjunction with the user guides
provided for See You.

SeeYou and Scoring

It is recommended that, as far as possible, the scoring function should be separated from the
downloading of Flight Recorders and, if possible, assessment of airspace infringements. This
allows the scorer to concentrate on flight analysis and scoring issues.

The scorer should be proficient at using SeeYou to enter tasks and analyse flight recordings
and should be familiar with competition organization and rules. Some understanding of the
BGA scoring system is useful, but a detailed knowledge of the scoring formulae is not
necessary.

SeeYou Competition is a module of SeeYou (see 4.5 for a more detailed discussion). Flights
are automatically analysed by SeeYou to check that the flight has been completed correctly
(start/finish lines have been crossed, turnpoints rounded, airspace not infringed etc.). It then
passes task and performance data (start/finish times and leg distances) to a scoring script
which calculates distances and speeds to allocate points to each pilot. A scoring script
suitable for all BGA-rated Competitions is provided.

Hardware and Software Requirements

Although it is pilot’s responsibility to ensure that the organisation has the ability to download
Flight Recorders it is advisable for the organisation to ensure that it can, if necessary provide
some assistance by having ready access to cables, memory card readers, and software for
downloading commonly used Flight Recorders.

Many contest organisations now require pilots to hand in their flight evidence on memory
devices, to email their traces, or to download their Flight Recorders themselves using their
own computers, or using computers provided by the organisation for this purpose.
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Arrangements and procedures for downloading Flight Recorders and submitting flight traces
should be clearly notified in the Local Rules.

Data Storage
Take regular backups of all data, especially the CUC file, at appropriate points, at least daily.

Although the CUC file can be set to autosave at frequent intervals during the scoring
process, it is highly recommended that a separate copy be made, especially when changing
status from Preliminary to Unofficial and Unofficial to Final. This makes it easier to roll back
to a known point if necessary.

Keep a written log of any manual adjustments or corrections made and any penalties
applied. This will assist in ensuring that, should day performances need to be recalculated,
any manual adjustments which will need to be reapplied are not overlooked. Also note times
that each day’s scores change from Preliminary to Unofficial and Unofficial to Final.

Submission to BGA

When overall final results are compiled for sending to the BGA, ensure that all FAI licence
numbers have been included and that a note is included to indicate for shared gliders, which
pilots flew as P1 on each day.

Flight Recorder Evidence

Now that it is acceptable to allow secure IGC files to be delivered on computer media, the
organiser needs to have a suitable card media reader available. This method of presentation
actually saves the organiser time in collecting the data required and is to be encouraged.

The Director must establish that a competitor has no objection to the release of their Flight
Recorder evidence before distributing any copies of it. It is recommended that this be
explained prior to the start of the competition and announced at the first briefing. Any
competitor's request to the organisers to restrict the release of their evidence must be
respected. After the final competition results have been produced, all data from competitors
requiring confidentiality must be deleted. It is also recommended that that it is made clear to
competitors that it is their responsibility to clear the Flight Recorder memory as appropriate.

Whilst the scorer will probably have obtained down-loading software to provide data in the
standard IGC format for most propriety Flight Recorders, the onus is on the competitor to
ensure that suitable software is provided to the organisation. It is suggested that the Local
Rules state this fact as well as advising competitors which types of Flight Recorder software
is already held.

Current GPS analysis programs highlight any anomalies with the recorded data. All
anomalies should be investigated by a visual inspection if they occur between start and finish
and all recordings should be viewed at the control points to ensure that the occasional
‘phantom position’ points are spotted. ‘Phantom position’ points are normally fairly obvious as
the displacement from the rest of the recording usually exceeds a kilometre. Clearly the
effect of a ‘phantom point’ that gives control anywhere in the flight must be discounted.

Directors should note that it is now a requirement to have a complete flight log of the day
including all flying on the day. This requirement is to ensure that evidence that may have
shown a land-out and re-launch or engine start in the case of motor-glider before the start, is
not deliberately lost. Such evidence may take the form of several IGC files.
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Competitors are, to the best of our knowledge, an honest bunch. There are however, a
number of simple checks that can be made, if required, to allay any suspicion. View traces to
check that the direction of thermal drifts is similar to other competitors. For Flight Recorders
that record GPS height, check this mirrors the barograph trace. If there is a particular
suspect, install a flight recorder in the tug used to tow them and compare traces for that part
of the flight. Closely compare landing and take-off times with the observed records.

Flight Recorder Evidence - Additional Requirements for Turbo and Motor Gliders
Motor-gliders and turbo-equipped gliders are able to compete fully with pure gliders.
Directors should be particularly aware of need to monitor FRs to ensure that engine use is
recorded and that the flight recorders used are in fact recording noise. This can be achieved
by ensuring baseline noise is apparent on the traces and also comparing this with real
engine start noise recorded either on self launch or on mandatory turbo engine test.

Only flight recorders that are IGC approved and carry operative noise sensing (ENL) or other
approved means of sensing engine operation are now permitted for gliders fitted with any
means of propulsion. The logging interval must be set to 6 seconds or less whether the glider
has a small self-retrieving power plant, is a self-launcher or pure glider. To cater for older
loggers where this may be a problem due to memory size, if the logger is not capable of
recording a trace of 10hours duration at 6 seconds, then a maximum of 12 seconds remains
permissible.

The requirement to test the noise or other approved sensor of FRs in gliders with MOP by
engine test is now only mandatory on the first day of the competition. It is at the discretion of
the Competition Director to require an engine test for logger integrity purposes each day
although the rules allow a pilot to test his turbo regardless as long as he/she does not
exceed the maximum engine run allowance time of 30 seconds. If the engine run time is
exceeded, a penalty structure of 1 point per second is applicable. Directors should, however,
note that this time limit is for engine operating cleanly at full power.

FRs incorporating micro-switch engine control, e.g. EW “b” model, are no longer acceptable
except for use with pure gliders and as a special exception with self-launching electric
powered gliders. With the case of electric powered gliders, where engine use cannot be
definitively verified by IGC FRs with noise sensors intended for noisy i/c engines due to the
very low noise level, a FR with micro-switch engine control must be used to either control the
whole flight including position and height or simply to control the use of engine only with the
position and height control being realised from another FR. In this special case, it will be
necessary to ensure that the aircraft is suitably scrutineered for integrity of the micro-switch
circuit before the first flight of the competition. The integrity of the system is then
automatically checked each day as the pilot cycles the engine doors/engine pylon prior to
launch and on closing down the engine. The engine must be regarded as in use if the engine
doors are open or the pylon erected as defined by the micro-switch actuation. Control of
engine use using this method is not regarded as suitably secure for general use but it has
been decided to make this special exception for electric motor-gliders due to the unusual
situation that owners of self launching electric gliders find themselves in at present with no
reasonable fully IGC approved FR solution.
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2.20. Penalties

The approved penalty table is split into sections depending on type of offence, with differing
penalties depending on whether it is a first occurrence of that particular offence, a second
occurrence or subsequent occurrence. Airspace penalties are rightly placed within the
dangerous flying section. Directors are urged to carefully read the penalty structure to
evaluate its contents.

There must be no discretion within the penalty structure and penalties must be consistently
applied. In many cases, the penalty for a first offence is a “warning” only. This, along with all
other penalties, must take the form of a notification to the pilot, ideally in written form,
together with annotation on the score sheet clearly identifying the penalty and what it was
awarded for. The intention is to ensure that pilot and peers are fully aware that the penalties
are being administered, even if warning penalties, to promote compliance. It is not
acceptable to regard a general warning to all pilots as a first offence warning. Any penalty
must be earned individually by demonstrated specific actions that are in breach of the rules.

Dangerous or Hazardous Flying

This can take many forms and the various scenarios in most cases have a different penalty
structure. Advice on the monitoring of conduct and administration of this type of penalty
follows:-

¢ Cloud flying — incorrect protocol. Whilst this penalty may be extremely hard to award,
due to burden of proof, it is intended to discourage, and hopefully eliminate, the
sloppy and sometimes deliberately poor use of radio when cloud flying. There have
been cases where pilots have been deliberately vague and have failed to call when
clear of cloud, with the effect of increasing the tactical advantage of being “first in.”
The correct radio protocol and airmanship considerations are clearly noted within the
Rules and adherence to these are necessary from a sporting and safety perspective.

e Cloud flying within 10km of airfield centre or any start point. The 10km is now
measured from the centre of each start point and also the airfield reference point as
defined. This applies throughout the day and does not just apply to pre-start situation.

e Flying outside C of A limits

e Minor airspace infringement including prohibited parachute zones — defined as
“Single or multiple penetrations of prohibited airspace NOT simultaneously greater
than 200m horizontally and 100’ vertically”. This penalty is designed to be significant
but not draconian and is intended to discourage accidental and very minor
transgressions. An example might be cutting airspace horizontally whilst circling or
bobbing vertically. Note that any number of such minor infringements may be made
on a particular contest day incurring just one penalty.

e Significant airspace infringement including prohibited parachute zones — defined as
“Single or multiple penetrations of prohibited airspace simultaneously greater than
200m horizontally and 100’ vertically”. This penalty is very significant at 500 points
with further sanctions for further infringements of this nature on subsequent days.
Note that any number of similar infringements may be made on a day incurring just
the one penalty. A minor infringement followed by a major infringement will not result
in two penalties but just the higher penalty for major infringement on that day.

e Finish — incorrect landing pattern, if specified. This is a specific penalty that can be
awarded for failure to stick to specific briefed landing instructions. Directors will have
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to take into consideration the defence of a possible necessity to deviate from any

briefed instructions, if not doing so would have clearly led to a dangerous situation

occurring, e.g. due to the actions of other finishing pilots or airfield traffic or possible
major wind fluctuations.
¢ Finish and approach to finish — hazardous or prohibited manoeuvre including:

a) Flight below 30’ AGL outside the declared airfield perimeter other than an
emergency straight-in approach where it is not possible to maintain safe
airspeed to maintain the minimum ground clearance or in the event of an out-
landing. FR evidence from 500’ above airfield elevation will be used to verify
any deliberate planning of energy management that leads to flight below the
minimum limit. Such proven cases will not be exempt from penalty.

b) Any approach that does not describe a descending flight path other than to
convert from a straight in approach to a go around or for reasons of flight
safety.

) Flight below 30’ inside airfield perimeter except when on landing approach.

The purpose of this three part rule is to eliminate the practice of contour following and
hedge hopping, whether the intention is to land ahead or go around after a finish resulting
in a safe but low final glide that may meet the legal requirements and ensures that the
landing area and any unexpected ground hazards are continually visible. The rule
effectively precludes the possibility of flying in ground effect except in the case where a
pilot has so little energy that flight below 30’ is inevitable to ensure safe arrival at the
airfield. Such a situation is effectively an emergency situation anyway and can easily be
verified by FR and visual observation to ensure it was not brought about by deliberate
energy mismanagement in the final 500’ of the flight. A decision made well back at higher
altitude, for example to leave lift and set off on final glide, cannot be held against the pilot
if ultimately the decision later results in an extremely marginal situation. For the purposes
of assessing whether a pilot maintains a descending profile, Directors should consider it
acceptable to still be dolphin flying between 200’ and 500’(although this should not be
briefed as acceptable) as at medium speeds and in a height band where strong thermals
may still prevail, it may well be impossible to maintain the necessary profile. However,
below 200’, where lift is usually rarer and the visibility of the landing area and proximity to
the ground are major issues, then a descending profile should be displayed to avoid
penalty. After crossing the finish line, the minimum safe height must be maintained until
the final part of the approach to land if a go around is selected.

The Director and the appointed finish line observer must between them monitor the
conduct of all aspects of the flying from being visible to the eye on approach and
completing the flight. It is not the intention of catching out pilots who are at 29 feet up or
on a virtually flat approach path but to cut out irresponsible hedge hopping and contour
following where it is not necessary to complete the task. Such flying will be clearly
identifiable.

Verification of any of the final glide conduct should not be routinely checked by FR
analysis but where dangerous conduct is observed, can offer additional evidence within
the limits of its resolution.

April 2016 ©British Gliding Association 2016 Page 45 of 78



BGA Competition Organisers’ Guide

2.21. Competition Forums and Feedback

The Competitions Committee recognises that communication and consultation between
itself, competition organisers and pilots is essential and sees competition forums as one very
effective way of achieving this. Directors of Nationals are required and Directors of Regionals
are strongly encouraged to hold at least one forum during their competition.

As well as providing a platform for feedback to the organisation about their own competition,
these forums allow the Competitions Committee to keep abreast of developing issues that
are seen as important within the competition community and to consult on proposed or
recently introduced changes to rules and recommended practices.

Forums may be arranged on an ad-hoc basis by the Director at any time and may cover any
topic or topics chosen by the Director or by the pilots present. In addition, however, the
Competitions Committee may wish to seek input on specific matters of concern and may
wish to “seed” topics for discussion.

Guidelines for Arranging a Competition Forum

e Pre-Announce in the Local Rules. If pilots know in advance that a forum will be held,
it may help them get their thoughts together and add to the effectiveness of the
exercise.

e Consider asking for suggested forum topics in advance. That could give you a good
idea as to what is “hot”.

e Pick your time. Consider when you are likely to get a receptive audience. Just after a
scrub briefing will give the highest attendance, but will be hard to plan in advance. On
the other hand a pre-planned evening meeting may find most of your pilots otherwise
occupied unless it is linked to some other event that you know will be popular..

e Start on a specific topic that you already know will provoke debate. Avoid opening
with “Does anyone have a topic they want to discuss” You are very likely to get the
“Stunned Mullet” response.

e Pick up other topics as the discussion develops. There may be a tendency to drift off-
topic. Note interest in any new issue, and come back to it later.

o Consider a “Panel” approach. Sometimes a “Panel of Experts” can be a good way of
getting things moving since questions can be asked direct from the floor, or by the
chairman if the audience is shy. Pick your panel carefully in advance.

e Spread the load. Get someone else from your organisation to take notes. It's not easy
both to chair the discussion and make a decent record.

o Don'tlet a few noisy people distort the feeling of the meeting. Where there is
disagreement consider taking a show of hands to make sure any “silent majority” gets
proper recognition.

e Include a summary of your forum in your Director’s report.
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PART 3 - CHECKLISTS

3.1. Getting Started

Competition

Nationals, Regionals, Non-Rated?

Application to
BGA

Unless you are running a Nationals, in which case you will have
gone through a bidding process, you will need to advise the BGA
of your intentions to run a rated competition. In either case, it is
essential that the information required in section 1.6 is
communicated by March 1% in the contest year.

Clubs are free to set entry fees for Regional Competitions. Decide

Fees and entry fee, deposit amount and due date. Consider special offers

Charges such as discount for early booking etc. Set due date for payment
of fees. Decide if you need a refund policy.

Promotion How is the competition going to be advertised?

Web Presence

Onglide? Home-Grown?, Will you have a blog?

Entry Admin

Entry list automated on website or manually using club office staff
or other volunteer. Bank account for entry fees? Sort codes and
Account number to allow direct transfers.

People

Who will be Director, Deputy Director, Met-Man, Tasksetter,
Scorer, Airspace Officer Safety Officer, Control, Launch Marshalls,
Stewards, General Helpers. Will there be enough people to help
throughout the competition?

Tugs

Enough to launch each class within 1 hour. Arrange well in
advance, or risk having too few. Don’t forget to allow for outages.

Accommodation

Where will competitors stay: bunkhouse? local B&B'’s (list?). How
many pitches? Will you charge for camping/caravans? Are
electric hook-ups available?

Refuse Disposal

You will need more than usual. Hire a skip?

Catering

There will be many mouths to feed. This can be a great revenue
source for your club but will need dedicated staff and facilities.

Communications

How will you communicate with competitors at the competition?
Notice Boards/PA/Text Messages/Airband/Website?

Radio

Do you have enough air band handhelds? Is there a base-
station? Consider range and readability of handhelds if not.

April 2016

©British Gliding Association 2016

Page 47 of 78



BGA Competition Organisers’ Guide

Local Rules Who will write these?

Sniffers A sniffer should be on call every day. Has this been organised?

Will normal club operations be continuing during the competition?
Club Operations | If so do you have a procedure for coordinating club flying with
competition activity?

Have you appointed a deputy director to take over if necessary?

Deputy Director . :
puty This is a requirement of the rules?

Stewards Have you appointed competition stewards?

Where will briefings take place and will pilots have adequate
Briefings seating and table space? What presentation aids are available?
Computer projector and screen almost essential.
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3.2. Airspace

Have you appointed an Airspace Officer ?(This is a

Airspace Officer .
requirement)

Have you published advance airspace information in your

Advance Information
Local Rules? (3 weeks before the comp)

Check it has been created and is correct. It may not appear

Ccompetition NOTAM | il close to a week before the competition.

Airspace Coordination | Have you received it? Do you understand the Coordination
Notice (ACN) Arrangements? Are you clear on how you will comply?

Have you obtained contact details for other airspace users
Co-ordination in your likely task areas who may have to be contacted?
No good looking for their numbers on the day.

Have you identified any airspace hazards in your local area
Local Hazards that visiting pilots may not be aware of? These should be
highlighted in your briefing.

Have you taken steps to ensure that any short-notice
Temporary Hazards temporary hazards can be identified? (Red Arrows phone
line, AIS InfoLine, for instance)

Have you identified the potential airspace dispensations
that you may wish to make use of in your likely task areas?
(Nuclear site fences, Bath Gap, Daventry Box etc) If any
prior action is required to invoke them, have you taken it?

Airspace Dispensations

Do you intend to issue supplementary airspace files to the
Airspace Files competitors for use in their moving-map devices? If so,
how will these be distributed?
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3.3. Safety

Has a Safety Officer been Appointed? This is a requirement of

Safety Officer the rules.

Emergency Action Do you have an emergency action plan and Is everyone
Plan aware of it and their role in it?

If other flying operations will be taking place at the host site
during the competition, have you considered possible conflicts
and alerted the other users? If club-flying is planned to
continue, has a club/competition liaison procedure been
agreed and published?

Coordination with
Other Flying on Site

Have you thought through the potential safety issues

Safety During connected with launching and worked out how to deal with
Launches them, and briefed your ground crews? (See “Safety” in Part
2),
Safety During P
Finishes Ditto finishing
There are likely to be a lot of visitors unfamiliar with your site
Ground-Traffic and your normal safety procedures. Are any additional traffic-
Safety control measures and associated sighage in place or
available? NB this applies to pedestrians as well as vehicles.
Pilots’ Safety Are you clear on the role of the PSC and the procedures
Committee associated with it? (See the relevant section in Part 2)

Have you included local hazards in your briefing material?

Local Hazards (E.G any local unlandable disused airfields?)
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3.4. Control
Control Area Have you allocated a separate room or area?
People Are people available throughout the competition to run control?
P Do they know what they have to do?
, Tables/Desks Chairs. Office Supplies, Pin boards and White
Equipment X . .
Boards. Supplies of pins and dry-wipe markers
Computers Will people use their personal machines or do you need to
P provide one or more? Internet Access? Cable or WiFi?
Will you have a dedicated printer? Is it fast enough? Don’t
Printers underestimate the printing load. Up to three alternate task
sheets plus results sheets per pilot per day, plus sundry other
bits of paper. All produced before briefing each morning.
. Where will the competition officials call home? Scorer, Met
Accommodation Man, Task-Setter, Director all need workspace.
List of entries, Contact Numbers of local airfields, Contact
Information numbers for local services? Copies of emergency procedures.
Copy of Competition Rulebook
. Is there secure storage for pilots’ property (loggers and memory
Security .
devices). Is the control centre lockable?
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3.5. Meteorology

Do you have a dedicated met man for the whole competition? If
not, can you provide met briefing cover every day? If not, use
Met Man someone with competition met briefing experience. Has a
briefing format been communicated to the volunteers and have
they practiced preparing it?

Met forecasting is practically impossible these days without

Internet : ) .
good internet access. Is this available?

Best not to attempt live internet at briefing. Images should

Briefing ideally be pre-loaded to memory sticks.

Will you have the ability to update forecasts during the day?

Ad-Hoc updating This is invaluable on days when launching may be delayed.
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3.6. Task Setting

Director

Do you have a task-setter for every day of the competition? Is
there a back-up in case of illness or other absence?

Task-Setter

Establish where, and when, you will receive your meteorological
information. If necessary, more detailed information can be paid
for through some of the subscription services that the Met Office
provide.

Director

Ensure adequate computing and printing/copying facilities are
available. Ideally connected to the internet and a competition
LAN with Printer. The tasksetter is going to want to look at
weather forecasts, NOTAMs etc and will need to print task
sheets.

Director

Ensure SeeYou is available for task setting and scoring. SeeYou
from Naviter is the only complete competition management
system with inbuilt scoring that creates the task sheet to the
required standard.

Airspace

The likely temporary airspace for a particular day can be
established the evening before a competition day. It is useful
that the Task Setter has this information when he discusses the
task shape/distances with the Met Man.

Task-Setter

Before breakfast check the likely task areas, thermal strengths
and soaring ‘window ’'with Met Man. Calculate best-worst case
task lengths based on information available. Where confidence
is high consider a Task A and a Task B. Where confidence is
lower consider adding additional fall-backs and potentially
different task directions.

Confirm airspace for the day with Task Setter and how this may

Airspace impact on the final tasks that have been decided by the Task-
Setter.
Airspace Provide information for Task-Sheet in format required.

Task-Setter

Create tasks on See-You and in the format required.

Review Tasks independently of Task Setter. Involve Airspace
and Met-Man if necessary. Check task sheets for suitability and

Director , . . e .
ensure that trigraphs, turning point descriptions, airspace and
ATZ information are correct.

Admin Print and copy Task Sheets.
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3.7. Ground Marshalling

Do you have enough capable volunteers for every day of the

Team competition?

Hi-Viz Vests One per marshal plus some spares

Have you determined the format of the grid? Are you clear on how
Grid Plan the grid positions are to be calculated and communicated to the
pilots from day to day?

Grid Cones Or equivalent. How many do you need?

Release Check | Not everyone will want to bother, but some will and you can’t wait
Ropes until the tug is there.

Invaluable. One per marshal plus a couple of spares. Know how to

Rope Hooks use them (Two marshals per rope pulling in opposite directions)
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3.8. Scoring
Software Have you organized access to SeeYou licence(s)
Scorer Has a scorer been appointed who is familiar with the scoring
software? Is there a back-up in case of absence?
Does the scorer have exclusive use of a computer? Is there a
Hardware ;
back-up available?
Security Do you have the means of storing competitors’ property

(loggers and/or memory devices) overnight if necessary?
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PART 4 - REFERENCE
4.1 Example of the Daily Schedule at a Single-Class Regionals

The following table shows the daily schedule at a single-class regionals. It is intended to
illustrate what a competition day is like from the Organisation’s point of view. Details will
differ from club to club and between the different types of competition. Although it may not be
written down, the Director and Competition Officials at every competition will be working to
ensure that each day is conducted in accordance with a schedule not unlike this.

When

07:15

What

Preliminary Met

Who

Met —Man

Notes/Detail

Review preliminary forecast.

Review Tasksetter Identify potential tasking options .
07:30 Preliminary Airspace  Tasksetter Review NOTAMs & RA(T)s
Check Check AIS Info Line (0500 354802) for new restrictions.
07:45 Preliminary Tasks Tasksetter Refine task options.
08:30 Morning Meeting Director Confirm previous day’s scores can be published at
Met Man Unofficial status.
Tasksetter
Airspace Review any organisation, safety, penalty or other issues
Safety to be dealt with or mentioned at briefing.
Launchmaster
Control Review airspace issues, NOTAMS & RA(T)s
Scorer Review Met and Task Options

Chief Grid Marshal

Airfield operations and gridding Plan for the day
Identify ATC Units and airfields to be advised
Admin issues to be raised at briefing.

Publish rig and grid instructions to competitors if not
already done

No Later Than Club Flying Liaison Director Discuss planned club operations and any issues arising.
09:15 Club Duty
Instructor
Before briefing Publish unofficial Scorer Print Unofficial score sheets with time and date of
scores from previous  Control publication for distribution at briefing.
day Upload to Onglide.
NLT 09:00 Obtain grid briefing Chief Grid To permit gridding before briefing. CGM may need to
from Launchmaster. Marshall & helpers  look into morning meeting to get briefed if grid position
Post grid positions not previously decided.
notice and lay out
Grid Markers
NLT 09:30 Produce Master Met  Met Man Files for presentation on-screen plus any printed data
Briefing for pin-board or pilots.
Copy files to Control server.
NLT 09:30 Produce Task and Tasksetter Tasks to Control server for printing
Airspace Briefing
Data and
Tasksheets
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NLT 09:45 If Gliders arrive on grid  Pilots Assisted and directed by CGM and marshalls where
grid before necessary
briefing;
otherwise as
directed
NLT 09:45 Print Met Briefing Met man with help ~ Post on briefing pin board and place on pilots’ tables in
Sheets from Control briefing area
NLT 09:55 Print Task and Tasksetter Place on pilots’ tables in briefing area
Score Sheets Control
10:00 Day Contest Briefing  Everyone See separate Briefing Checklist
ASAP Brief Tug Pilots Launchmaster Ensure Tugs are ready and fuelled.
Review operation for the day including DZs and
landing/taxiing procedure for launch phase.
ASAP Contact RAF Control RAF Wittering - Low Flying Ops Sgn — LF Booking Cell
Wittering and (LFBC) Tel: 01780 783838 Ext 5008. Free Phone 0800
LATCC (Mil) LJAO 515544. Free Fax 0800 3892225)
as per ACN
LATCC (Mil) LJAO, ATC Supervisor (Tel: 01489 61 2417).
Advise ATC Units ACN No. ACN 2011-08-0028 (Locations and contact
and airfields in task details in UKAIP)
area
ASAP Configure tasks for Scorer/Control

today in Onglide

Any time after

Make blog entry

Any authorised

NB: Blogs may be made at any time provided they are

briefing blogger relevant and interesting. However, no task information
should be given until the actual task being flown is
confirmed.

ASAP Compress Grid CGM & Marshalls Late arrivals to back of grid.

At discretion Launch Thermal Director Determine thermal strength and cloudbase. Use
prior to launch Sniffer information to inform max start height, launch time and
phase start open time decisions.
NLT 30 mins If new task not Director Use sign-off sheet to ensure all pilots aware
before 1st previously briefed is
launch to be flown. Brief all

pilots (on grid)
NLT 15 mins If previously briefed Director Use sign-off sheet to ensure all pilots aware
before 1° fallback task is to be
launch flown or if change to

AAT designated

time is made. Inform

pilots
As soon as Set wind and task in ~ Control
task to be Onglide and

flown is known

rebrief/launch time
info.
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NLT 10 mins If launching is to be Director Announcement will usually be made on Grid PA and on

before delayed, announce competition frequency

announced new earliest 1%

earliest 1° launch time. The length of launch time slippages will be determined

launch time by circumstances, but should not usually be less than
15 minutes at a time. If pilots have been waiting on the
grid for an extended period, consideration should be
given to a longer comfort/snack break.

NLT 10 mins Stop Club Director Contact Club Duty Instructor or LPC and request

before actual Launching cessation of club launching

1* launch

NLT 10 mins Announce 10 mins Director Announcement will usually be made on Grid PA and on

before actual to 1* launch. Control competition frequency. May be repeated on clubhouse

1* launch PA by control.

NLT 5 mins Announce 5minsto Director Announcement will usually be made on Grid PA and on

before actual 1% launch Control competition frequency. May be repeated on clubhouse

1*' launch PA by control.

NLT 5 mins Invoke Traffic Chief Grid Specific measures, including signage and manning,

before actual Control measures Marshall prepared in advance for every possible launch position.

1*' launch Goal is to ensure separation of vehicles and people from
launching gliders or tugs that are landing or taxiing.

At discretion Commence Launchmaster Pilots offered launches in grid order. All to have been

launching offered launches with 1 hour

As soon as Confirm launching Control

launching on Onglide

starts

During Launch
Phase

Record launch
details

Control at grid

Glider ID, Pilot(s) Name(s), Tug ID, T/O Time.

Enter to Club Record system off-line(ideally same day).

As late as Decide Start Open Director Start Open Time >=Last Launch offer +15 mins + 1 min
practical Time per 200ft that that cloudbase exceeds 3,000 ft.

Advise Control
When advised Enter Start time and Control

by Director Max start Height on
Onglide
Start Open Announce Max Start  Director or Control  On Competition frequency
minus 10 Height and 10
minutes minutes to Start
Open
Start Open Announce Max Start  Director or Control ~ On Competition frequency
minus 5 Height and 5
minutes minutes to Start
Open
Start Open Announce Max Start  Director or Control  On Competition frequency

minus 1 minute

Height and 1 minute
to Start Open

Start Open

Announce Max Start
Height and Start
Line Open

Director or Control

On Competition frequency
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After Start

Monitor pilots’

Control

On Competition frequency

Open reporting start times Acknowledge and record on Onglide
At any time Make blog entry. Any authorised NB: Blogs may be made at any time provided they are
blogger relevant and interesting. However, no task information
should be given until the actual task being flown is
confirmed.
Once task Issue approval for Director Only when risk of relights is low.
under way club flying to restart
During Task Man telephones for Control Handle landouts using Onglide built-in process.
landouts and deal
with any that arise.
NLT 0.75 hr Stop club winch Director Contact Club Duty Instructor or LPC and request
before first launching cessation of club winch operations immediately
expected
finisher
Before Finishes  Station lookouts on Grid Marshall Only necessary if finish is from East

landing threshold (if
necessary) to
control walkers

In good time Monitor finish calls Director, backed- On competition frequency. Record finishes on Onglide
for finishes and acknowledge. up by Control
Respond with
information if
required
During Observe all finishes Director Ensure finishes meet safety and airmanship
Finishes from suitable Safety Officer requirements. Note IDs of any offenders
vantage point
During Log all finishers Director, backed Note glider ID and Time in Onglide
Finishes up by Control
During Clear landing areas Grid Marshalls Ensure landed gliders are cleared quickly to edge of
Finishes landing areas. Supervise movements thereafter if
necessary. Goal is to maximise available landing area
for later finishers.
When all Restart club Director Contact Club Duty Instructor to restart club operations.
gliders operations
accounted for
Within 60 Receive pilots’ flight Control NB: All loggers and/or memory devices to be logged in
minutes of evidence and out using a written log. All such devices to be kept
each landing securely under the personal supervision of a
competition official or in safe.
ASAP Carry out scoring Scorer
process
ASAP Confirm all pilots Director Have landouts made contact with their crews? Count
accounted for. Conrol other finishers. If necessary, invoke missing aircraft
procedure.
ASAP Evening Meeting Director Review Preliminary Scores
Scorer Monitor engine tests for turbos on first day

Other interested

Apply any Penalties
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officials Consider any Protests
ASAP Print and publish Scorer Including upload to Onglide
Day score sheet at
Preliminary status
At any time Make blog entry Any authorised NB: This can be done the same evening, or the following
regarding outcome  blogger morning, if more convenient.

of the day
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4.2. Task Sheet Specification

The Rules require that a task sheet must be supplied to pilots for each task briefed with
minimum content to include the following:-

Task date and priority designation

Written task description to include trigraph, description and co-ordinates of start,
finish, and turnpoints in degrees and decimal minutes, task length, leg lengths, leg
headings(degrees true),

Written observation zone description where task is an AAT

Graphic interpretation of task area (minimum size A5) showing all observation zones,
track lines, all relevant permanent airspace boundaries and any temporary
restricted/prohibited airspace including prohibited parachute zones identified as
shaded areas.

List of relevant temporary restricted/prohibited airspace and prohibited parachute
drop zones to be titled as ADDITIONAL PENALTY - to include time, location and
height descriptor as appropriate. In the event of any discrepancy between graphical
and text descriptions of such airspace/parachute zones, the text version will always
be authoritative.

Written list of relevant navigation warnings with descriptors as appropriate to be titled
as ADVISORY

Written list of relevant airspace exemptions in operation to be titled EXEMPTIONS.
Day QNE

Radio frequencies of any ATZ within 5km of track lines and start volume for speed
tasks and discretionary for Assigned Area Tasks.

See overleaf for an example Task Sheet.
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Task Information

Shenington Regionals 28th June 2013 TaskA

Type: Triangle - (263.8km)

Task distance: 263.8km

April 2016

Style Code Points | Latitude Longitude | Dis. |Crs.
Take off  [EDG ' Edgehill N52°05.097' W001°28.418' T
Start EDG {Edgehil  N52°05.097' woo1°28.418 |
1Point  |LIT  Littleport 'N52°27.895°  E000°19.293' 1129.6km  (70° |
2Point  |NPT | Newport Pagnall | N52°05.004' | W000°44.896" '84.5km 1 240° |
Finish ~ [EDG  [Edgehill N52°05.097' 'W001°28.418'  [49.7km  1270°
Landing | EDG | Edgehill N52°05.097' W001°28.418' T

W000°90.000' E000°35.000

1 y; N \."
o
O A\

Né1°4s. v @ \?o?m
\—4 > (A

All Co-ordinates Degrees and Decimal Minutes: All times Local

/4

ADDITIONAL PENALTY : Parachute Sites Deemed Permanently Active: Sibson 52 33.35 N 000 23.46 W 1.5 Nm; Chatteris
52 29.19 N 000 05.126 W 1.5 Nm; Hinton 52 01.36 N 001 12.16 W 1.5 Nm; Langar 52 53.38 N 000 54.16 W 1.5 Nm
RA(T) Red Arrows Duxford 52 05.25 N 000 08.10 E 13:00 to 15:00 4Nm

ADVISORY Battle of Britain flypast Sywell 52 05.25 N 00047.29 W 1500ft AGL13:00; Captive Balloon Nr St Neots 13.423 N
00015.661 W SFC to 1800AGL alt day.

EXEMPTIONS: None
ATZs: Northampton 122.700, Wyton 134.050, , Cranfield 122.850, Turweston 122.175

QNE +825ft QNH 1006

Control Telephone 07856 368383 (Backup) 0796S 525241) Director Tel: 07908790062
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4.3. Creating the Task Sheet

Task sheets meeting the required specification can be readily created using the most popular
SeeYou task setting software. Other task planning software has not been tested.

Producing a graphic interpretation that suitably illustrates the normal and any additional
restricted/prohibited airspace as well as the graphic details of the specific task is particularly
important. To achieve this when using SeeYou, task setters should consider turning off
unnecessary cluttering detail like turn points and their labels, waterways etc., perhaps
leaving just towns visible on the underlay. The normal airspace will need to have its graphic
detail specification changed within the program to ensure it is displayed in outline only,
preferably in black and somewhat thicker than the default setting — this will allow standard
airspace to show up clearly as a lattice across the task sheet map.

Additional prohibited/restricted airspace (Additional Penalty airspace) must be shown as
shaded. If the task sheets are to be produced by photocopying, this can be achieved by
printing a master copy with all airspace in outline only and then shading the master copy by
hand with a pencil or similar before photocopying. In this way, additional information labels
showing vertical airspace level definitions may be added by hand to any airspace area thus
offering additional clarity for pilots. Such additional labeling is not a requirement of the rules
however. Alternatively, organisers may wish to print task-sheets direct from SeeYou without
having to use photocopying. See the next reference section for advice on how this can be
achieved by creating an Additional Penalty airspace file for SeeYou.

In order for the map to be maintained at the required A5 size or bigger when using SeeYou,
care is required with the set out of the additional written information. Written into the SeeYou
software is automation to shrink the map giving preference to the number of lines of text
incorporated. This is why it is recommended to turn off the “written observation description”
section where the task is not an AAT. Additionally and most importantly, lines of manually
added text should be optimised to use up the bulk of each line thus minimising the number of
lines used. As an example, four sections of additional prohibited airspace (additional penalty
airspace) can be written as per the example below rather than listed vertically using 3 lines
and a further one for the title:

ADDITIONAL PENALTY — Sibson, WOG, RA(T) 5m rad Nxx.xx.xx E xx.xx.xx 1210-1320
local

The same “long line” listing approach should ideally be adopted also for ADVISORY and
EXEMPTION airspace as well as any other pertinent or required written data on the task
sheet.

You will have noticed that the three title classifications of ADDITIONAL PENALTY,
ADVISORY and EXEMPTION have been defined and standardised so that, from one event
to another, pilots will be clear on the intention of the information supplied.

Items to be included in the ADDITIONAL PENALTY written section should be self-
explanatory but must include all deemed active parachute zones, any RA(T)s, ATZs that
have been specified in the local rules as sensitive and requiring blanket prohibited status,
and any other airspace that has been activated by NOTAM and is therefore illegal to enter.
Whilst normal prohibited airspace like, for example, the Daventry CTA can and should be
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detailed in any verbal briefing, this should NOT be included within the title line of
ADDITIONAL PENALTY.

Items to be included in the written EXEMPTIONS section should be self explanatory but
might, for example include the Compton Box, Daventry Box or similar. The specification of
such areas made available to pilots at times during the event by exemption should be
detailed in the local rules.

Items to be included in ADVISORY should include any information regarding any activity
demanding pilot attention for safety purposes and will usually be other activity identified by
NOTAM that requires attention from pilots on the basis of good airmanship but is NOT
prohibited airspace. Please note that an additional requirement (since 2011) is to provide
detail on the task sheet of the radio frequency of all ATZs within 5km of the track lines. This
serves to remind pilots of their duty to avoid these unless they are in radio contact with the
radio service attached to the ATZ or have at least attempted to make contact before entering.
Such information should appear under the ADVISORY heading.

To avoid doubt, it is recommended that a declaration is added to the text notes to clarify the
format of co-ordinates (should be degrees and decimal minutes) and time zones of any times
given.

Don’t forget to add Control contact telephone numbers. This can be done without using
space in the text section if you put it in the footer.
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4.4. How to Produce an Additional Penalty Airspace File

Additional Penalty Zones on the Tasksheet map must be shaded. While it is fine to do this
by hand and then photo-copy the task-sheet, many organisers will wish to print task-sheets
direct from SeeYou without having to use photo-copying.

SeeYou can handle multiple airspace files in different formats simultaneously, so it is quite
feasible to create a file containing only the Additional Penalty Zones then set SeeYou up to
display this file on the task map in addition to normal airspace. Provided the zones in the
additional file are all set as the same class (class E is good), SeeYou can be set to display
these as shaded and all other classes as outline only.

The following method is used to create the file:

(None of this will make sense unless you have some familiarity with airspace text files in
OpenAir format. Fortunately the format is not difficult to master. See
http://www.winpilot.com/UsersGuide/UserAirspace.asp for a description of the OpenAir
format. You will also need to be able to use SPINE, the Notam programme written by Jeff
Goodenough and available free from http://www.jeffg.co.uk).

o Before the competition, create an OpenAir file containing the details of Parachute
Zones, ATZs and any other zones in the likely task areas that you might wish to
designate as Additional Penalty. This file will not be used directly, but will be used as
a source of zone definitions to be copied and pasted into the actual file. You could
create this file by downloading the full UK airspace file in OpenAir format from this
web page http://soaringweb.org/Airspace/UK/HomePage.html and then editing out
the stuff you don’t want (Like Control Zones and Airways etc, which are penalty
Zones already). Then change the airspace class definitions (the AC line) all to class
E. This can all be done in a text-editor such as Wordpad. Make sure you keep a
protected copy of this file as you will be using it every day of the competition.

e On the day, if there are NOTAMSs you wish to designate as Additional Penalty, use
SPINE to list only them by deleting all the others. Save the result in OpenAir format.
This saved file will be edited to become the Additional Penalty zone file, so you may
wish to rename it at this stage.

¢ Open this file and the source file together and copy/paste any zones you wish to add
from the source file.

o If there are no Additional Penalty NOTAMs on the day, but you do wish to use some
from your source file, simply create a new file by deleting all of the unwanted zones
from a saved copy of your source file or by creating a new file and copying/pasting as
before, or by editing yesterday'’s file whichever is the simpler.

e Check that all zones in your new Additional Penalty Airspace file have been set to
class E (SPINE sets the NOTAM zones to Class E automatically when you select
OpenAir output) and save the resulting file.

e In SeeYou, select your saved file for display using Tools/Airspace/Add

¢ In SeeYou, using Tools/Airspace/Options, set all airspace classes except E to
outlined only and Class E to whichever shaded setting suits your printer. Transparent
Fill is probably better for colour printing, but Solid Fill may be better for black and
white depending on the quality of the printer you intend to use.
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o Print the task sheet and check that the shaded Additional Penalty areas are clearly
visible. If not adjust the colour/fill parameters in SeeYou until they are.
e End
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4.5. Scoring

Setting up See You for Competition Use

For scoring, it is recommended that one computer per competition class be dedicated to run
the scoring software. Using laptop computers for this purpose can give the scorer some
freedom to work wherever is convenient to him/her.

It is not necessary to purchase a separate licence to use SeeYou for scoring a competition. If
you do not have a licensed copy of SeeYou, Naviter will supply a free licence for use in any
competition; see http://www.naviter.com/products/seeyou-competition/

For airspace checking, SeeYou Competition can be set up to automatically flag potential
violations, but the maximum vertical and horizontal infringements will need to be manually
assessed.

It is often useful for scorers to have access to spreadsheet and word processing software
and a printer.

Immediately before the competition starts, check the Competitions & Awards section of the
BGA website for the latest version of the scoring script (currently UK2016a) to include in your
SeeYou Competition.

The scoring script is a text file. Before use, you will need to use Notepad (or similar) to edit
the file, using the instructions included at the start of the script, to ensure that CompClass is
set to the correct Competition Class for the competition that you are scoring. This must be
done before importing the script into SeeYou Competition.

The scoring script receives flight analysis data (start/finish times, actual leg distances
achieved) from SeeYou Competition, calculates wind-handicapped distances and then
scores performances as described in the BGA Competitions Rule Book.

If results are to be published on Soaring Spot, then note that SeeYou automatically publishes
flight traces during preliminary scoring. If you wish to stop this happening, it will be necessary
to manually upload results after any traces that are not to be published have been removed
from the day’s sub-folder.

If results are to be published on Soaring Spot, then note that SeeYou Competition
automatically publishes flight traces during preliminary scoring. If you wish to stop this
happening, it will be necessary to manually upload results after any traces that are not to be
published have been removed from the day’s sub-folder.

Note: Some SeeYou settings can only be modified permanently from an account with
administrator privilege.

Ensure that the current BGA Waypoint list has been loaded, together with any locally defined
start, finish and control points.

Start up SeeYou, and under Tools>Options:

e Click on General and ensure that the
units for distance, speed etc. are set as desired. The recommended settings are: Distance;
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Km, Speed: km/h, Altitude: ft, Vertical Speed: kts, Wind: kts

e Click on Observation Zone and set appropriate default values for Start, Waypoints and Finish
(see BGA Competitions Rulebook: Sections 5.6,5.8 & 5.9).
Important: If setting up a finish line with a fixed orientation, the angle given should be the
direction that the finish line faces. i.e. if the finish line lies north-south and finishes will be
made from the west, then the finish line direction (Angle12) should be 270 degrees.

e Click on Flight and select how altitudes should be adjusted
SeeYou will use the airfield elevation and an average of readings from the Flight Recorder
immediately prior to launching to adjust altitude fixes to QNH or QFE according to this
selection. QNH is recommended.

Use File>Open to open the Competition file and then Edit>Contest Properties

e On General tab
Enter correct contest title, contest site, start/end dates, class name and enter airfield elevation
under takeoff altitude elevation. Note: airfield elevation may be adjusted by SeeYou as it
converts to metres before storing the value, and then back to feet for display.

e On Options tab
Ensure that Need tasks leg data in scoring script is checked.
If this is not done, the scoring script will not function.

e On Scoring Scripts tab
Import your copy of the scoring script (with the correct class already set).

e On Warnings Tab
Ensure that max recording interval (for Flight Recorders) is set to 12 seconds (BGA
Competitions Rulebook: Rule 5.5.6) and check the box for airspace violation is found so
that airspace violations will be flagged during the scoring process.

After Registration

When all pilots have registered, you can either manually enter competitor, glider and
Flight Recorder information using Edit>Add Pilot, or you can use Notepad to edit the
information directly into the Competition file (note: this is only possible with .CUC files. In
later versions of SeeYou, the .CUCX file is not editable outside SeeYou).

Ensure that all competitor and glider information is correct. Note: the default speed
indices given by SeeYou Competition for any glider type should not be used, as they do
not necessarily match the BGA speed indices. Correct speed indices are listed in the
BGA Competitions Rulebook: Section 7.3.

Scorers for National level competitions should note that Pilots' IGC Rankings can

be automatically updated from results on Soaring Spot, and should therefore ensure that
the relevant field in the SeeYou Competition file is correctly filled. See
http://www.sgp.aero/igcrankings/competitions/instructions-for-scorers.aspx for
instructions.

Additionally, in all rated competitions it is also useful to enter the pilots' FAI licence
numbers in the 'Registration’ field (this is done automatically during registration for users
of OnGlide). This will be needed to enable future plans to automate some of data
gathering for BGA rating list calculations.

Take extra care to ensure that the four character Flight Recorder idents have been
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correctly declared on entry forms, and recorded in the Pilot’'s details. SeeYou Competition
uses this ident to determine which pilot a flight trace is from.

You must not accept any Flight Recorder which has ‘X’ as the first digit of its ident. This
signifies a Flight Recorder which is not IGC approved (BGA Competitions Rulebook: Rule
5.5.1). The data from such devices is not sufficiently secure, and they may not properly
record pressure altitudes and engine noise levels.

Motor gliders and turbo gliders must have the Pure glider box unchecked for the engine
noise level checking to be enabled.

Scoring a Competition Day

Before launching commences:

¢ Check number of pilots competing. Any pilots no longer competing (i.e. formally
withdrawn or disqualified from the competition) must be marked as withdrawn (see
instructions below). This ensures that the correct number of participating pilots is
used in daily points calculations. This will need to be done on each subsequent day
on which the pilot is not competing.

e Obtain a forecast value for contest wind strength and direction for preliminary scoring.
(BGA Competition Rulebook: Rule 5.23.5). Normally the forecast wind for 3000ft will
be a suitable estimate for this purpose.

e If any gliders are being shared by more than one P1, note which pilot is flying as P1
on that day. This information will be required when reporting overall contest results to
the BGA.

After launching commences

Use Edit>Add Day to create a new contest day.

On the Pilot list, Edit>Edit Performance for each withdrawn pilot and enter a lowercase w in
their Day performance Tag box

Use Edit>Day Properties and do the following:

e Select the Task tab and load the announced task in SeeYou Competition
o Select the Task Options tab and ensure that:
o For Fixed Course , Enhanced Option Fixed Course Tasks and Distance
handicapped Tasks:
Type must be set to Racing Task and Task Time must be zero.
For Distance handicapped Tasks ‘use task from IGC file’ must also be
selected. N.B For more help on scoring Distance Handicap Tasks please refer
to the help files provided with the task setting software.
o For AATs:
Type must be set to Assigned Areas Task and Task Time is set to the
appropriate task time in hours and minutes..
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The scoring script checks to see whether or not Task Time has been set. If Task
Time is zero it will score a Fixed Course Task, if Task Time is not zero then it scores
an Assigned Area Task.
Note: The value selected for Type is not available to the scoring script. It can only
deduce task type from the setting of the task time. Therefore extra care should be
taken to ensure that both values are correctly set.
o Select the Observation Zones tab and ensure that Observation Zones are set up
correctly for the day’s task. Default values may not always apply (e.g. AAT, enhanced
TP zones, alternate finish line). Check that missed observation zones tolerance is
set to 0.5km.
e Select the General tab
o inthe Tag box, enter the estimate for Contest Wind in the form ddd/ss where
ddd is the wind direction in degrees and ss is the wind speed in knots or for
Distance Handicap Tasks enter ‘H’ followed by the Handicapped Task
Distance, in the form Hddd.d (this ensures that the scoring script scores
appropriately for the task type and does not need to apply handicaps or wind
data to the pilots’ performances).

After the above steps have been completed, ensure that the correct task information is being
displayed in the header of the SeeYou Competition screen. In particular check that the class
and task type are correct on the third line of the header.

After Start Line Opening is Announced

e Use Edit>Day Properties and:
o On the Task Options tab, enter the start gate open time under No start
before
o Onthe Observation Zone tab, select Start and enter the announced
maximum start height (QNH) in the maximum altitude box.

Preliminary Scoring

As SeeYou Competition receives flight traces, it will analyse them for start/end times and
completion of task and pass data to the scoring script for allocation of points. If ‘Auto
evaluate’ is set, the software will monitor folders where flight traces are being downloaded or
copied to and automatically score them as they are received.

If using Soaring Spot or OnGlide, preliminary scores may be updated on the internet as they
are received.

Check any warning displayed in the right hand column against a pilot’'s performance. Further
detail on the warning may be displayed in the pane below the pilot performances.

Typical warnings are:

e User Wrng. This is displayed if the pilot has been flagged as withdrawn or if the flight
has been scored manually.
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e Fix Rate. Flight Recorder fix rate greater than the maximum allowed.

Some Volksloggers, when set to a 12 second recording interval, may make very
occasional fixes that are 13 seconds apart. This will be flagged by SeeYou, but is not
normally a problem.

e Alt Corr. The Flight Recorder pressure altitude was corrected by more than a limit set
in contest properties (default 150ft) compared to takeoff height.

o No start found. Check start gate open time and examine trace to see if a valid start
was made. SeeYou Competition does not accept a missed zone tolerance for starts,
S0 it may be necessary to adjust the start line zone for this pilot (in View Flight) to
force SeeYou Competition to score his flight, and then apply the appropriate penalty.

o Point ‘name’ not rounded OK. The named TP was missed, but rounded within the
missed zone tolerance (should be set to 0.5km). SeeYou Competition will score the
flight as completed, but the appropriate penalty for a missed TP zone must be
applied. If the TP zone was missed by more than missed zone tolerance, SeeYou
Competition will score the pilot as having landed out at the most advantageous point.

e Start alt. Pilot has exceeded max start altitude within defined time limit prior to
starting.

e High ENL. Engine noise level has exceeded limit set in Contest Properties. Check to
determine whether or not this is engine running prior to start and, if not, that SeeYou
has correctly detected ‘end of soaring’.

o Airspace violation found. If airspace checking enabled, pilot has infringed airspace.
Details of the airspace infringed and time of infringement will be displayed in the
lower pane.

If SeeYou Competition fails to score a pilot at all, then check that the correct flight trace has
been submitted. On the first day it is probable that some Flight Recorder idents will be found
to have been incorrectly recorded. Other common errors include the pilot submitting a trace
with the wrong date, or an earlier flight before relighting, or an aerotow retrieve. Many pilots
forget to set the date and time on EW Model ‘D’ recorders after a battery change, which
results in a flight trace for a date in 1990 being submitted. It is possible to rename the file
with the correct three digits for the day’s date.

In some cases (such as failure to detect an engine start) you can force SeeYou Competition
to land the pilot out at a fixed point by using Edit>Edit Performance to set an appropriate
time for ‘end of soaring’.

Manual Scoring

If any pilots have launched as part of the competition but cannot provide a valid flight trace,
then the following must be done in order to ensure that correct number of pilots launched is
used in scoring calculations.

Use Edit>Edit Performance to edit the appropriate pilot's day performance, check the box
Flight Evaluated Manually and enter a time for takeoff (does not need to be accurate), and
enter 0/0 in the Tag box. Also enter an appropriate note in the Comments box.

It is also possible to use manual scoring to score a pilot on a fixed course task, who has
provided sufficient flight evidence, but SeeYou Competition has been unable to score it
properly, for example if the start or finish have not registered properly.
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e As above, edit the pilot’s day performance, check the box Flight Evaluated Manually
and enter a time for Takeoff, Start and, for finishers, a Finish time. Enter n/d in the
Tag box, where n is number of completed legs and, if non-zero, d represents the
distance in kilometres remaining on an uncompleted leg (i.e. distance to next
turnpoint). Do not enter any data in the Speed or Distance boxes; windicapped
values for speed and distance will be calculated by the script using data entered in

the Tag box

For example, on a four leg task:
4/0 = all four legs completed i.e. finished the task.
3/38.6 = three legs completed and 38.6km of the fourth leg remaining.
2/0 = pilot completed two legs and landed at the second turnpoint

Enter a note in the Comments box to indicate that the pilot has been manually
scored and why.

If you later want to re-evaluate a manually scored flight using the Flight Recorder trace then
Edit>Edit Performance, click on the Reset button, clear the manual inputs, and then click on
the Recalculate button.

When Preliminary Scoring is Complete

Day status must not be changed to Unofficial until:

e Actual Contest Wind has been derived and scores recalculated using that value
e All violations and warnings have been checked and appropriate penalties
applied.(BGA Competitions Rulebook: Section 7.1)

To derive Actual Contest Wind, use a representative sample (e.g. top 10 pilots) of flight
traces to determine a suitable estimate for Contest Wind based on thermal drift.

For each pilot in the sample, use Edit>Edit Performance>View Flight to access the
standard SeeYou flight analysis tool, and on the Statistics page, the wind strength, direction
and time spent in each 500ft height band is reported. Choose a representative height band
for the day and use this to make up a sample of wind strengths and directions from which an
average can be calculated.

When the new value for Contest Wind is entered (in Edit>Day Properties), you will need to
initiate a recalculation of the scores by selecting any pilot and using Edit>Edit Performance
and clicking on the ‘Recalculate’ button. This will result in the windicapped distances and
scores being recalculated for all pilots.

When publishing the scores keep either a printed copy of the scores for your records, or take
a copy of the appropriate HTML file in the SeeYou Competition day folder.

After Issuing Unofficial Scores

Refer to BGA Competitions Rulebook: Section 5.24 When it has been agreed with the
Director that scores can be published as Final, edit the Contest Day properties and change
status to Final, then publish the Final scores. As above, keep a copy of the published scores.

Airspace Infringements
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Where an airspace infringement has been flagged, the flight trace should be assessed so
that, if necessary, penalties can be applied. It is useful to have someone other than the
scorer to undertake this assessment and report any actual infringements to the Director for
follow up actions with pilots concerned and for determination of penalties to be applied in the
Unofficial scores.

When analysing flight traces it is best to ensure that SeeYou is set up to report all altitudes in
QNH. This can be set in Tool>Options as described earlier.

The following points should be noted:

altitudes stored by the Flight Recorder are based on pressure readings, and rounded
to the nearest metre.

SeeYou calculates a takeoff altitude by averaging a small number of pressure
readings, immediately prior to launching. This gives a takeoff height based on
pressure relative to 1013.25 hPa.

SeeYou compares the calculated takeoff altitude with the known airfield elevation, to
calculate an offset which is then used to convert pressure altitudes in the flight trace
to QNH altitudes (or QFE if selected).

It also compares the takeoff pressure altitude with the value entered for Day QNH
and calculates the offset that must be applied to calculate QNE values for assessing
Flight Levels. SeeYou Competition can flag instances where this offset is greater than
a set limit (default is +/-150ft)

For any flagged infringement, first confirm that it is in a penalty area, and not in
airspace that has been notified as being available to competitors.

If the pilot has infringed a penalty area, then determine the maximum extents of the
infringement, vertically in feet, and horizontally in metres, by examining the flight trace
using Edit>Edit Performance>View Flight, or by opening the Flight Trace directly
with SeeYou. Use the standard SeeYou measuring tool to measure horizontal
distances and read QNH altitudes from fixes, in the map or barograph view.

Any reported Flight Level height infringements must be cross-checked against the
nominal QNH altitude for the base of the Flight Level according to the Day QNE, to
determine if this altitude was actually exceeded.

Using the Day QNE and Airfield Elevation, the nominal QNH for a Flight Level can be
determined as follows.

If Day QNE is declared on the task sheets as 320ft, and Airfield Elevation is 410ft,
then Nominal QNH for Flight Level 55 = (5500-320+410)ft = 5590ft QNH

(See BGA Competitions Rulebook: Appendix 2).

Apply any penalties according to Section 34 of the BGA Competitions Rulebook.

If a pilot protests the penalty, it may be necessary to reassess the infringement using
a calibration chart.

Reference should be made to readings from the calibration chart for the altitudes
closest to the take off height and closest to the infringement height. Then divide the
difference between the reference altitudes by the difference between the indicated
altitudes on the calibration chart. This factor is then used as a representative value for
the average drift in accuracy over the desired altitude range.

For example: The takeoff and maximum infringement altitudes are found to be 270ft
and 3307ft respectively.

The calibration chart for the Flight Recorder used shows reference altitudes of Om
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and 1000m as nearest to these altitudes. At these points the calibration shows that
the Flight Recorder actually reads -2m and 1007m respectively.

Difference between reference altitudes divided by difference between indicated
altitudes

= (1000 — 0) / (1007-(-2)) = 1000/1009 = 0.991

Adjusted violation height = (0.991 * 3307)ft = 3277.237ft = 3278ft (rounding up)
So the infringement in this case is reduced by 9ft.

The manufacturer supplied calibration charts for some Flight Recorders (including
most LX types) do not give a Om reference point. In such cases it will be necessary to
use only the reference altitude nearest to the infringement altitude and use the
indicated error to adjust the infringement altitude.

¢ Inthe above example, the indicated altitude at 1000m is 1007m, so the Flight
Recorder over reads by 7m.
Adjusted violation height = (3307 - (7*3.2808))ft = 3284.034ft = 3285ft (rounding up)
So the infringement in this case is reduced by 22ft.
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4.6. Height Verification Procedure

For checking for vertical infringement in airspace designated by flight level (eg. FL45),
all logged heights will be referenced in any case to FLO. If an airspace infringement is
indicated then the pilot must submit a valid calibration chart within the protest period to avoid
an additional penalty in accordance with 5.5.7 as failure to provide a calibration chart will
result in the assumption that the calibrated height puts any logged points 100 feet vertically
further into the airspace than indicated with any airspace penalties varied accordingly. Any
adjustment required by reference to the calibration chart is deduced by identifying the
difference in error between calibrated chart reading at the 1013.25 HPa pressure altitude or
that at the ambient test pressure altitude with that closest to height of infringement. In any
case, the calibration will be used to reduce, eliminate or increase the airspace penalty as
appropriate. Where a chart shows a calibration at a particular test altitude more than once,
the most advantageous calibration favouring the pilot should be used in all cases.

For checking for vertical infringement in airspace designated by flight altitude above
sea level (eg. 3500ALT), any verification software will correct all logged readings by the
offset of documented airfield altitude from logged take-off height. If an airspace infringement
is indicated then the pilot must submit a valid calibration chart within the protest period to
avoid an additional penalty in accordance with 5.5.7 as failure to provide a calibration chart
will result in the assumption that the calibrated height puts any logged points 100 feet
vertically further into the airspace than indicated with any airspace penalties varied
accordingly. Any adjustment required by reference to the calibration chart is deduced by
identifying the difference in error between calibrated chart reading closest to airfield height
compared to that closest to height of infringement. In any case, the calibration will be used to
reduce, eliminate or increase the airspace penalty as appropriate. Where a chart shows a
calibration at a particular test altitude more than once, the most advantageous calibration
favouring the pilot should be used in all cases.

For checking for vertical infringement of start height above airfield elevation (eg.
4000ft QFE) or during the pre-start interval, any verification software will correct all logged
readings by the offset of documented airfield altitude from logged take-off height. If an
infringement is indicated then the pilot may submit a valid calibration chart within the protest
period. Any adjustment required by reference to the calibration chart is deduced by
identifying the difference in error between calibrated chart reading closest to airfield height
compared to that closest to height of infringement. In any case, the calibration will be used to
reduce, eliminate or increase the airspace penalty as appropriate. Where a chart shows a
calibration at a particular test altitude more than once, the most advantageous calibration
favouring the pilot should be used in all cases.
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4.7 Weighing Procedure

In order to discourage pilots from either flying heavier than their maximum certificated mass
or, in the case of the Club Class Nationals, at a mass greater than declared for handicap
purposes, it is hecessary to have in place the means to check weigh gliders either on the
way to the grid or on the grid as seen fit. To enable this, it may be necessary within the Local
Rules to set limitations when ballast may be loaded or dropped. As weighing is a time-
consuming operation it is expected that such weighing will be done on a random sample
basis or when it is suspected that limits are being exceeded. A simple weighing procedure is
specified in the Rules at 3.3.2 and states:-

"Gliders should be weighed with wings balanced and with all equipment required for
flight. If weighing takes place on the way to the grid it must be ensured that the glider has
a small into wind component. The mass of the pilot is also measured at this time. The
intended take off mass is the combined mass of glider, all equipment, pilot and any
calibration error that is registered for the weighing scales in use. A tolerance of +/- 1% is
additionally allowed before overweight or out of handicap penalties are considered."

Determining flight mass of gliders outdoors has errors associated due to wind strength and
its direction relative to the wings so it must be assured that any benefit is given to the pilot so
that in the event of being found overweight there is no doubt that this has occurred.
Therefore check weighing should only be contemplated when the wind is modest and the
operation is set up in a direction that allows a wind component from leading to trailing edge
of wing. If conditions do not permit weighing outside and there is a pressing need to weigh a
glider, this should be done in a hangar.

Directors expecting to carry out check-weighing at their competition should ensure that
suitable equipment is available and tested beforehand. It is suggested that the advice of a
local BGA inspector is sought on this matter well in advance of the competition.
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4.8 Directors Report

It is important to complete and submit your report, along with the results, as soon as possible
after the competition. Please note that we are not seeking to ascertain the precise nhumber of
hand washbasins or toilets available during the competition! What we are seeking is
information on all services provided, problems encountered, and events that occurred, as this
information is used extensively by the Competitions and Awards Committee to assist in
making any changes to the rules for the following year.

Following the significant change to the airspace penalties and the ongoing infringements that
have taken place year on year, it is now a requirement for the Directors report to include
details of each and every airspace infringement including brief details of location and cause
following interview with the pilot concerned. The Competition committee will be compiling this
data for ongoing statistical purposes and to assess trends that might require action in future.

DIRECTORS REPORT TEMPLATE

ENTRY DETAILS

A list of the number of competitors and classes. The handicap range of each class and the Entry Fees
charged.

RESULTS
Please include pilots FAI No. and final position
For team entries, it is very important to include both pilots FAI No, the points each scored on a daily

basis and the day winners score. This is necessary so that the BGA pilot rating list may be compiled
for the following year.

ORGANISATION

A brief description of the organising team.
TUGS

A list of the number and type of tugs available. Any problems encountered in launching the task
groups within the allocated time.

EACILITIES

A brief description of the facilities provided including Catering, Waste Disposal, Shower facilities,
Loudspeaker system.

PILOT SAFETY COMMITTEE

Any reported incidents.

SCORING SYSTEM

Scoring and analysis software used. Any problems encountered.

METEOROLOGY AND TASK SETTING

Brief overview of the meteorology facilities provided for the event and description of the tasks set for
each day.

COMPETITIVE FAIRNESS
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The number and detail of any airspace infringements — in order to compile statistics and to review the
new procedures, it is now a requirement to fully document each and every infringement including the
Directors view on the cause following interview with the pilot concerned.

Any protests involving the Stewards.

ACCIDENTS/INCIDENTS

A brief report on any accidents or incidents incurred during the competition.

RECOMMENDATIONS

A brief report on recommendations, interpretation of the rules, specific practices, you feel could be
adopted by the Competition & Awards Committee for inclusion in the Competition Handbook.

FORUM SUMMARY

If you held a forum during your competition, please include a brief summary of the discussions in your
report.
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